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Welcome to Axiom Contract
Management

Syntellis’s contract modeling and analytics tool helps organizations better predict and manage
payments, and leverage a data-driven approach for improved payer negotiations. With this software,
you can estimate net revenue by patient, and better manage contracts, claims, and payments across
your organization from both managed care and government payers.

Syntellis’s Axiom Contract Management solution helps healthcare organizations:

l Inform payer contract negotiations using empirical and modeled data

l Understand the financial impact of proposed changes to contract terms

l Optimize estimation of net patient revenue across inpatient and outpatient populations

What is covered in this document
This guide is for Axiom Contract Management administrators. System administration involves basic
configuration and maintenance tasks, some that you perform only once, and some that you need to
perform regularly. You perform most admin tasks from the Axiom Contract Management Web Client.
Any tasks that are performed from the Desktop Client are noted as such.

System administrators model contracts that other users view and use in processing claims and creating
and viewing reports.

1
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This guide includes the following administrations features and tasks:

l Importing data – Building claim formats and other import formats, importing files to the system,
and viewing import activity

l Managing attributes – Creating, editing, enabling /disabling, and deleting attributes
l Modeling contracts– including adding contracts (adding versions, provisions, attributes, clauses

and terms, thresholds and limits; attaching files and importing rates; copying contracts; and
more)

l Managing simulations – Creating, editing, and copying simulations; mapping simulations to drill-
down reporting

l Security – Application security roles and their associated access rights
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What’s new
Welcome to Version 2020.4 of Axiom Contract Management!

Enhancements in this release include:

Updated UI improves visibility and navigation for contract pages

The newUI provides a cleaner layout for easier viewing of, and navigating to, contract levels and their
associated settings. For example, each contract level now has its own page, providing a larger workspace,
and the process for navigating from one contract level to another is consistent. Other enhancements
include icons and other indicators that make it easy to tell at a glance whether a contract level has
additional information such as attributes or attached documents.

New search functionality added to contract modeling

Along with improved navigation, the updated UI for contract pages and dialogs provides new sort and
filter functionality for contract table grids, and search functionality for some dialog fields.

Main menu additions

Axiom Contract Management’s main menu header is enhanced with some new links that provide quick
access to context help pages, software version and copyright information, a queued tasks indicator, and
logout.

Manage clause and term descriptions

This feature has been updated with additional functionality and moved from the Clause/Terms page to
the Admin menu in themain menu header. From the Clause/Term Descriptions page, administrators can
search for, add, edit, and remove descriptions used for clauses and terms.

October 15, 2020Quarterly Release

Each quarter, 3M provides an update to the 3M GPS Grouper software integrated into Axiom Contract
Management. This update includes grouping, pricing, and regulatory updates to the APC and State-
specific eAPG groupers.
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July 15, 2020 Quarterly Release

� Why use this feature
Each quarter, 3M provides an update to the 3M GPS Grouper software integrated into Axiom Contract
Management. This update includes grouping, pricing, and regulatory updates to the APC and State-
specific eAPG groupers. These updates are necessary for clients to get the latest software and regulatory
changes for accurately grouping and pricing APC and eAPG claims.

� How this feature works
On a quarterly basis, 3M releases product Service Packs containing updates to its Group & Price service
software. Syntellis maintains Medicare contracts for many clients, and partners with 3M to handle
APC and eAPG calculations and to keep current with all regulatory changes that occur.

Where: The Group and Pricemenu in the Claims tab of Axiom Contract Management, and Group and
Price jobs in the Axiom Scheduler.

Who: Axiom Contract Management Administrators who create contracts with the CMS Outpatient
calculation basis on a clause or term, and other users working with applicable claims.

How: The Development team creates the update from the quarterly download. Customer Success
updates the clients’ schedules and customer contracts to the required Medicare changes. The client
picks up available schedules for any new contract updates between quarters.
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Understanding the Axiom Contract Management system
Axiom Contract Management is a web application backed by an SQL database that stores contract terms,
patient claims, and payment information. The system uses the contract payment terms and the patient
claim information to calculate an expected payment for every claim submitted by the provider.

Understanding the flow of data

From billing to Axiom Contract Management
Axiom Contract Management requires many pieces of data to function properly. It is important to
understand the entire process of how data comes into, and moves through, the system.

As shown in the following diagram, when billable procedures are performed at a hospital, services data is
entered directly into the hospital’s information systems (HIS). Patient Accounting generates claim data
from this information and sends a bill in the form of an 837i 5010 for institutional claims, and as an 837p
5010 for professional claims, to the payer.

As these claims are sent out each day, a copy also goes to the Axiom Contract Management system.

NOTE: These claims should be collected after they have been sent through a claim scrubber so that
they reflect exactly what the payer receives.
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After import to Axiom Contract Management, claims arematched to the associated payer contracts
modeled in the system. These contracts can be very sophisticated and may contain combinations of
services being paid at fee schedules, per diem payments, lesser of terms, thresholds, stop losses, and
various other reimbursement methodologies. Ultimately, an expected payment is generated for each
claim that has a matching contract.

In addition, 835 remittance responses, along with posted payments and payer adjustments, flow into
Axiom Contract Management on a daily basis. With these five pieces of information (i.e., contract terms,
claim data, payments, adjustments, and remittance responses), the expected payment/contractual
generated by Axiom Contract Management allows you to identify which claims have or have not been
paid correctly.
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Managing data
This section provides information about importing data to Axiom Contract Management and integrating
data from the Contract Management system with other Axiom systems, as those integrations become
available in future releases.

About accessing data in the AxiomDesktop Client
Key Axiom Contract Management assets are available in the Axiom platform so that Axiom Contract
Management system administrators can pull and synchronize key contract, claim, and calculated claim-
level estimated payment details for use in the Desktop Client. This integration allows users to take
advantage of Axiom tools like the Axiom Scheduler Jobs Library and Axiom Reports.

During Contract Management installation, data is pulled from Axiom Contract Management and stored
in the following Axiom tables in the Table Library:

l CM Claim level estimated payment
l CM ClaimNumbers
l CM ContractDetails
l CM Last Import

In addition to the tables, an Axiom job, called Import Claim Level Estimated Payment, is created in the
Axiom Scheduler Library under Contract Management. This job helps share data from Axiom DSS with
Axiom Contract Management.

2

Administrator's Guide Axiom Contract Management │ 11



When this job runs, it retrieves all of the contract detail, claim-level expected payments, and claim detail,
and uses it to update the four CM tables and keep the data in sync. Whenever users import new claims,
modify claims, calculate a payer, and so on, this job captures these changes when it runs. Generally, this
job would be set to run with the full nightly import (CMA Full Import job).

Importing data to Axiom Contract Management
Axiom Contract Management imports data in different formats depending on the type of data file the
system is attempting to access. Generally, data provided for import into the system can be categorized
into four types:

l Claims data – Claim files, both institutional and professional.
l Financial data – Payments and adjustments, both institutional and professional.
l Additional data – Primary Insurance Plan Codes, claim number mapping files, user-defined field

data, Professional Primary Insurance Plan Codes, and other contract terms.
l Remittance data – Institutional and Professional 835 files.

Claims and Financial data files must meet certain requirements before importing to Axiom Contract
Management, and they must also be in specific formats. Additional data and Remittance data files also
have format requirements. For details, see Client file specifications and Understanding data formats.

Currently, flat text files (Financial data and Additional data) can be imported using the Kreg Unified
Importer or the Axiom ETL Importer.

NOTE: The Kreg Unified Importer will eventually be phased out.

In general, the import process consists of the following main steps, depending on which importer you
use.

If using the Kreg Unified Importer... If using the Axiom ETL Importer...

1. Build fixed-width import format files
(for payments and adjustments).

2. Create an import batch. (See also:
About import batches)

3. Add files to the Import Task List.

1. Set up Axiom ETL import for flat files.

2. Ensure files are in the correct
format.

3. Drop the files in the appropriate
folders that were set up in step 1,
where they will be picked up by the
importer during the nightly import.

4. Files are auto-imported to the system during the nightly import. An Import
Summary Report is created after each successful nightly import. You can also view
import activity in Axiom Contract Management.
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Understanding data formats
All formats are built during system implementation; however, the system administrator is responsible for
ensuring that any format changes are reflected in Axiom Contract Management for importing to
continue smoothly.

IMPORTANT: If you do not maintain data formats in the system, you run the risk of inaccuracies in
your database.

� About formatting claim files for import

NOTE: UB and 1500 files are no longer accepted as import file types.

The Axiom Contract Management claim dataset is populated mainly by 837i and 837p files, which are
typically provided to the server on a scheduled basis for import and recalculation. These files must
adhere strictly to the 5010 standards and should be the “scrubbed” claims from the claims
clearinghouse.

� About formatting financial data files for import
Financial information such as payments and adjustments are imported using a format as well; however,
these file types are inherently different from the 837i/837p 5010 claim files. Typically, they are provided to
the Axiom Contract Management server as flat ASCII text files. Users with a Support license can build
fixed-width import formats if using the Kreg Unified Importer. For more information, see About
importing data to Axiom Contract Management.

Client file specifications
Client files imported to Axiom Contract Management must meet the specifications detailed in the
following tables for each file type.

� Claim data

Institutional
claims 837i
(required)

Description

Format 837i files must adhere strictly to the 5010 standards. All
claims must be “scrubbed.” Scrubbed claims typically come
from a claims clearinghouse (E-Premis, Emdeon, WebMD,
CareMedic, etc.).
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Institutional
claims 837i
(required)

Description

Frequency Daily. Claim files are dropped to predetermined import
folder locations on the Axiom Contract Management server
on a daily basis for the previous day’s billing cycle. The
folder should be named
\\servername\KHData\Hospital\837i5010.

Naming
convention

Institutional files must be unique text files and must not
have any spaces or special characters in the name. Syntellis
requires that each file have a unique name concatenated
with a date stamp for the day it was created (example:
YYYYMMDD837i.txt).

Professional
claims 837p
(optional)

Description

Format 837p files must adhere strictly to the 5010 format standards.

Frequency Daily. Claim files are dropped to predetermined import
folder locations on the Axiom Contract Management server
on a daily basis for the previous day’s billing cycle. The
folder should be named
\\servername\KHData\Hospital\837p5010.

Naming
convention

Professional files must be unique text files and must not
have any spaces or special characters in the name. Syntellis
requires that each file have a unique name concatenated
with a date stamp for the day it was created (example:
YYYYMMDD837p.txt).

� Financial data

Institutional
Payments
(required)

Description

Format Flat ASCII text file or Pipe (|) Delimited. Payments should be
positive values, reversals would be negative values.
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Institutional
Payments
(required)

Description

Requested
fields

Required:

l Account #
l Posting Date
l Payment Amount

Optional:

l UCRN/Claim Number
l Payer Code
l Payment Date
l Posting Code/Transaction Code

Filter All records excluding payments received for professional
services (services billed on 837p).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s actual posted payments.
The folder should be named
\\servername\KHData\Hospital\Pay.

Naming
convention

Institutional Payment files must be unique text files and
must not have any spaces or special characters in the name.
Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDDPayI.txt).

Institutional
Adjustments
(required)

Description

Format Flat ASCII text file or Pipe (|) Delimited. Adjustments should
be positive values, reversals should be negative values.
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Institutional
Adjustments
(required)

Description

Requested
fields

Required:

l Account #
l Posting Date
l Adjustment Amount

Optional:

l UCRN/Claim Number
l Payer Code
l Payment Date
l Posting Code/Transaction Code

Filter Adjustment Postings. All records excluding adjustments
received for professional services (services billed on 837p).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder should
be named \\servername\KHData\Hospital\Adj.

Naming
convention

Institutional Contractual (adjustment) files must be unique
text files and must not have any spaces or special characters
in the name. Syntellis requires that each file have a unique
name concatenated with a date stamp for the day it was
created (example: YYYYMMDDAdjI.txt).

Professional
Payments
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited. Payments should be
positive values, reversals would be negative values.
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Professional
Payments
(optional)

Description

Requested
fields

Required:

l Account #
l Posting Date
l Payment Amount

Optional:

l UCRN/Claim Number
l Payer Code
l Payment Date
l Posting Code/Transaction Code

Filter All records excluding payments received for institutional
services (services billed on 837i).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder should
be named \\servername\KHData\Hospital\Payp.

Naming
convention

Professional Payment files must be unique text files and
must not have any spaces or special characters in the name.
Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDDPayP.txt).

Professional
Adjustments
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited. Adjustments should
be positive values, reversals should be negative values.
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Professional
Adjustments
(optional)

Description

Requested
fields

Required:

l Account #
l Posting Date
l Adjustment Amount

Optional:

l UCRN/Claim Number
l Payer Code
l Payment Date
l Posting Code/Transaction Code

Filter Adjustment Postings. All records excluding adjustments
received for institutional services (services billed on 837i).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder should
be named \\servername\KHData\Hospital\Adjp.

Naming
convention

Professional Contractual (adjustment) files must be unique
text files and must not have any spaces or special characters
in the name. Syntellis requires that each file have a unique
name concatenated with a date stamp for the day it was
created (Example: YYYYMMDDAdjP.txt).

� Additional data

Institutional
Primary
Insurance Plan
Code
(required)

Description

Format Flat ASCII text file or Pipe (|) Delimited.
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Institutional
Primary
Insurance Plan
Code
(required)

Description

Requested
fields

Required:

l Account #
l Primary Insurance Plan Code

Optional:

l UCRN/Claim number

Filter l Primary Insurance Only
l Date criteria based on 6 - 12month sliding window

(todayminus 6months)

Frequency Daily. To be dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\Ins.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (Example:
YYYYMMDDPlanI.txt).

Institutional
Primary
Insurance DRG
Code
(required)

Description

Format Flat ASCII text file or Pipe (|) Delimited. DRG codes should
be zero filled to 3 characters. For example, DRG 57 should
be 057.

Administrator's Guide Axiom Contract Management │ 19



Institutional
Primary
Insurance DRG
Code
(required)

Description

Requested
fields

Required:
l Account #
l Primary Insurance DRG Code

Optional:

l UCRN/Claim Number

Filter l Exclude Professional Accounts
l Primary Insurance Only
l Date criteria based on 6 - 12month sliding window

(todayminus 6months)

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\DRG.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDdrg.txt).

Claim Number
Mapping File
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited.

Requested
fields

This file is needed if the claim number on the claim does not
match the posting files from the hospital system.
Required:
l Account #
l UCRN/Claim Number

Filter Date criteria based on 6month sliding window (todayminus
6months).
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Claim Number
Mapping File
(optional)

Description

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\Map.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDUCRN.txt).

User Defined
Fields
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited.

Requested
fields

Required:
l Account #
l User Defined Field (UDF)

Filter Date criteria based on 6 - 12month sliding window (today
minus 6months)

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. Each user
defined field feed needs a unique folder. These folders
should be named \\servername\KHData\Hospital\UDF#
where # is the number of the UDF.

Naming
convention

Files must be unique text files and must not have any spaces
or special characters in the name. Syntellis requires that
each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDudf1.txt).
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Professional
Primary
Insurance Plan
Code
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited.

Requested
fields

Required:
l Account #
l Primary Insurance Plan Code

Optional:

l UCRN/Claim Number

Filter l Exclude Institutional Accounts
l Primary payor only

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\InsP.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDPlanP.txt).

� Remittance data

Institutional
and
Professional
835 (optional)

Description

Format 835 files must adhere strictly to the 5010 standards. These
files should come from the payer and not be edited.

Frequency Daily. 835 files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\8355010.
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Institutional
and
Professional
835 (optional)

Description

Naming
convention

Institutional files must be unique text files and must not
have any spaces or special characters in the name. Syntellis
requires that each file have a unique name concatenated
with a date stamp for the day it was created (example:
YYYYMMDD835.txt).

Build a fixed-width import format
Fixed-width import formats are generally used for importing payments and adjustments data to Axiom
Contract Management in fixed-width ASCII text files. To get the information from these downloads into
the system, you need to build a format for them. Their formats are different from a claim format in that
the data is provided in fixed columns instead of floating fields like on a claim file.

To create a file format:
1. Run UnifiedImport.exe.

2. From themenu bar, select Import Setup > Spec Imports.

3. In the System drop-down, select CMA.

4. From the Import Type drop-down, select Fixed.

5. Select Folder Based Import.

6. From the Table Name drop-down, select the name of the Import Table. In the following example,
a format is being defined to import to the CMAPostings table.

Axiom Contract Management Flat File Tables are categorized as follows:

l CMA Postings – Payments, Adjustments
l CMA Library Tables – Library APC, DRG, etc.
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l Additional Data Upload – DRG, User-Defined Data, Payer Code, etc.
By selecting CMA as the System, and in this example, CMA Postings, you are setting up the system
to create a CMA Postings format.

7. Select the Import Folder Location. You need to select a sample file to build flat file formats.
Click the ellipsis button next to Import Folder and select the folder where your sample file is
located.

IMPORTANT: This samplemust be free of print characters, headers and footers, and must
reside in a subfolder with the file path: \\YOURSERVERNAME\Data\Import.

8. Create a new format: Click New to open the format building windowwith the sample data for
selection, as shown in the following example.

9. In the fields at the top of the window, enter a format name and description.

10. On the lower left, in the Fields box, select the field to specify, and then select the data location in
the Field Selection box.

11. Click Accept to save the values to the database.
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NOTE: Fields in bold are considered required fields and must be specified. Fields in italics have
already been specified.

12. After completing the format for your flat file, click Save.

� Advanced flat file import options
When building an Axiom Contract Management Postings format, set up Advanced Options for the
following fields:

Amount Field
l Decimal Settings – Use this option to set whether the amount field in your file uses a space

decimal, implied decimal, or normal decimal. Depending on the way the amount field is provided,
you must select the appropriate DecimalFunctionID. Following are examples of each:

Space Decimal: 100 00→ 100.00

Implied Decimal: 10000→ 100.00

Normal Decimal: 100.00→ 100.00

l Negative placement – In some cases, negative signs (-) are attached to the front of the amount,
and in others, they are attached at the end.

IMPORTANT: For the amount to populate correctly, payments and adjustments must be
positive values. Negative values are acceptable, but they will appear as a credit on any
accounts.

l Reverse sign – For the amount to populate correctly, payments and adjustments must be
positive values. Negative values are acceptable, but they will appear as a credit on any accounts.

l Post Category – Adjustment vs. Payment

l Post Prof Indicator – Professional vs. Institutional
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About import batches
Import batches are groups of tasks that tell Axiom Contract Management where to look for files, and
once found, which formats to apply to them. After you have the file to import, the next step in importing
data to the system using the Kreg Unified Importer (KUI) is creating import batches. When using the KUI,
you must create an import batch to get data into the system.

You need to create batches for claim files and any flat files that you want to import.

The setup for importing data is folder-based: a format is joined with a folder location, and upon import,
any file residing in that folder is brought in using the set format code.

IMPORTANT: All import folders must be subfolders of \\YOURSERVERNAME\Data\Import, and must
not have any spaces in the folder or file name.

After importation, the file is date-time stamped and moved into a mirrored IMPORTED folder for later
reference if needed.

Create an import batch
NOTE: This topic applies to the Kreg Unified Importer.

Before creating an import batch, you need to understand the following different types of batches used in
Axiom Contract Management:

l Claims should import from the 837i or 837p 5010 format files (claims are imported using the 5010
l Flat-file import – Folder and File based

To create an import batch:
1. Select the import type. An import batch can be created for each of the import types. Select the

appropriate import type from the drop-down menu.

2. Name and create your batch. Click Create to create a blank batch for the import type selected in
step 1.
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3. Select files/folders to import and the target table to import to. On the left side of the screen, from
Table Name drop-down, select the target table.

4. Click the ellipsis button next to Import Folder and then select the import folder or file location.

5. In the Format box, select the format to apply to the folder.

NOTE: Only one format can be applied to a folder.

6. Add your item to the batch. Click the right arrows button to add your item to the batch selected in
the drop-down on the right side of the window. To remove an item from the list, select it and
press theDelete key.

IMPORTANT: Do NOT click the Delete button. Clicking the Delete button will not remove an
item from the list, but instead will delete your whole batch.

7. Next, add the import batch to the Import Task List.
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Add import batches to the Import Task List
After creating import batches, to process them during the import, you must add them to the Import
Task List import queue. Simply creating the batches does not cause the files and folders in those batches
to import automatically.

To add or remove items from the Import Task List:
1. In the Unified Importer, from themenu bar, select Import >Manage Tasks.

2. Create and define a Task Group:

a. At the top right, click the Create New button.

b. From the Batch Types drop-down, select the batch type, and then click the arrow buttons
to add the batch types to the Task Group on the right.

In the example below, the Task Group “Example Task Group” is defined with a number of
batch imports of various types. These will all run when the Task Group is called by the
import process.
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Set up Axiom ETL import for flat files
Use these instructions to set up folder and file options for importing flat files using the Axiom ETL
importer. These instructions are for system implementers setting up new systems and for support
technicians setting up import folders for additional flat file types.

IMPORTANT: When copying an existing flat import file, you must add an underscore (_) and a
number or other character to the end of the copied file name: a copy of a file named CM_TempXXX
would be named CM_TempXXX_y; so a copy of the file CM_TempClaimAddDRG could be named
CM_TempClaimAddDRG_2.

To set up import file and folder options:
1. In the AxiomWindows Client, from the Axiom ribbon tab, click Imports > Contract Management>

[desired flat file import type] > Edit.

2. In the Flat File Import dialog, click the Source tab.

3. For Import Type, select File.

4. In File Import Options, select the following:
a. For File type, select Delimited file.

b. For Source path, select Use specified path.

c. In the Source folder field, enter the path to the folder in which the client will place files. This
is also the folder from which the importer picks up the files.

NOTE: This path is provided by the client. For requirements, see Client file
specifications.

d. For Import from, selectMultiple files.

5. In the File Options section, select the following:
a. If the first row of data in your file has column headers, select the option First row has

column names.
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b. For Delimiter character, select the pipe delimiter (|).

c. For Text qualifier character, the default is quotemarks. If your file uses a different qualifier
character, enter it in this field.

6. In theMultiple File Options section, select the following:
a. For Import order, select Creation date.

b. For Archive folder, this is the same path as the Source folder except that instead of a folder
named “Import” the folder is named “Imported,” as shown in the following example.

c. Ensure that the option Add timestamp prefix to file names when archiving successful
import files is selected.

7. If the client is using column header names in the file, click theMapping tab and then verify that
the information displayed in the Temp Table Column and Destination Column is correct.

8. If the information is not correct, select the line in the column and then type the correct heading.

9. Click Apply and then click OK.
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View import activity
To view your import activity:

1. Log in to the Axiom Contract Management Web Client.

2. In themain menu header, click Import Data and select View Batches.

TheManage Import Batches page opens.

Manage Import Batches page example

On theManage Import Batches page, you can view all data entered in the system, organized by
batch (1 file = 1 batch). This is useful when looking at the View a Claim Summary tab, where the
batch number is provided and you want to locatemore information about that batch.

Each claim batch has the following information columns:

l Import Date
l Type (type of claim)
l Batch #
l Claims Submitted (number of claims)
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l # Rejected
l # Accepted
l # Exceptions
l # Calculated
l Total Charges
l Notes – This column contains notes about the imported file; for example, if a file was not

imported because it is a duplicate, that is noted here.

3. To view batch information for Postings and other file imports, from the Select Import Type drop-
down, select Flat File Imports.

Flat file imports include payments and adjustments, as well as any additional data files you
submit, such as DRG or plan code files.

Some information is not available if the batch was imported as part of a historical data import.

TIP: In every view, the bottom left corner contains page navigation options. Click the arrows
to move to the next/previous page:

IMPORTANT: Do NOT delete batches unless instructed to do so by a member of the CMA
Support Team. If the batch information is deleted, it cannot be recreated.

About the Import Summary Report
All data entering the system runs through Syntellis’s auto-importer, which generally runs four to seven
days per week. It usually runs late at night or early in themorning so that it does not interfere with work
being done by users. When the import completes, if successful, you will receive an email confirming the
import and detailing the contents. The following is a list of terms and fields, with accompanying
definitions, found on the report.

� Import Summary Report definitions – CLAIMFILES

Field Definition

Batch Number System # assigned to each import file.

Import File Name Name and import location of file.
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Field Definition

# of Claims Read into
Temp

In Axiom Contract Management, all claims are loaded to a temporary
staging area before being transferred into the Live environment. This
allows us to run validation processes on the data to ensure the data is
correct. This number should tie to the number of billed claims in the
import file.

# of Late Charge Records Details howmany late charges were in the import file.

# of Claims Rejected to
Bad

In cases where bad data is provided, the system removes the records
associated to the bad claim and moves them into a separate area. For
details, see About problem file processing. You can run the Bad
Records report to check why any claims weremoved there. Reasons
vary as to why a claim would bemoved to bad, but most of the time it
is related to missing required data elements (e.g., account #), a
number that has a character in it and the system cannot convert it
correctly, or a bad date that does not convert. You should rarely see
anything detailed in this field. If you do, run the Rejected Records
report (available in Reports > Reports) or contact info@syntellis.com.

Valid Claim Total Charges Provides the total charges of the claims that were successfully
imported to the Live environment.

# Claims Transferred to
Live

This field indicates howmany of the temp records were imported to
the Live environment. It should be in line with the # of claims read into
temp column (unless records weremoved to bad).
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Field Definition

# Claim Exceptions In some cases, imported claims aremarked as exceptions. Following
are reasons for exception records:

l Trying to insert a series bill over an existing non-series bill claim
l Trying to insert a late charge onto a series bill
l Trying to insert a void over a series
l Trying to insert a non-series bill over an existing series bill
l Invalid Medicare Part B Type of Bill
l Trying to insert a zero payment bill into the system
l Trying to insert over higher charge claim
l Voided Claim
l Invalid Late Charge Bill (Incompatible Bill was imported after this

record)

The second sheet of the import summary report details all the
exceptions from the import, including the Bill ID (Patient Account
Number) linked to the claim in the system. In addition to Bill ID, the
supplementary details include: Batch Number, Import File Name,
Exception Reason, Bill Code, # of Claims, and Total Charges.

# of Claims Grouped Axiom Contract Management groups all outpatient claims into their
corresponding APCs based on the date of the episode of care and its
corresponding version of theMedicare APC schedule.

# of Claims Priced Any Medicare-based outpatient claim will price against the 3M pricer if
factors have been provided to Syntellis and a corresponding
calculation schedule has been built and assigned to the contract
provision. Please email your factors to info@syntellis.com.

# of Claims Calculated This field indicates the number of claims that found a contract and
calculated accordingly.

� Import Summary Report definitions – POSTINGS

Field Definition

Batch Number System assigned # to each import file.

Import File Name Name and import location of file.
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Field Definition

# of Postings Read into
Temp

In Axiom Contract Management, all claims are loaded into a temporary
staging area before they get transferred into the Live environment.
This allows us to run validation processes on the data to ensure the
data is correct. This # should tie to the # of posting records in the
import file.

# of Postings Rejected to
Bad

In cases where the data is bad, the system removes the records
associated with the bad claim and moves them to a separate area for
review by support staff. Reasons vary as to why a posting would be
moved to bad, but most of the time it is related to a missing required
field value, a number that has a character in it and the system cannot
convert it, or a bad date that does not convert. You should rarely see
anything detailed in this field. If you do, please contact
support@KaufmanHall.com.

# of BillIDs Imported Provides the number of unique account numbers in the posting file
being imported.

# ofMatching BillIDs Provides the number ofmatching billIDs found in the Live environment
for the postings being imported.

Total Valid Postings
Amount

Provides a summary of the valid posting records being imported.

NOTE: If any records are rejected to bad, their amounts are not
reflected in the Total Valid Postings Amount.

About problem file processing
When claims and remits are read into the system during the Axiom Contract Management Full Import
job, occasionally problem files occur. Problem files include duplicate files, files with invalid formats, and
files that cannot be read because of structural or other issues.

The system handles them as described in the following sections.

� Duplicate files
The system:

l Date-time stamps and copies the file to a Duplicate file folder under the EVCMA folder location
from which the file is read. If the Duplicate folder does not exist, the system creates it.

l Logs the attempt as a duplicate.
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Duplicate.
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l Updates the import report to show that the file is a duplicate and was skipped.
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Duplicate - Not Imported.

� Invalid format files
The system:

l Date-time stamps and copies the file to an Invalid file folder under the EVCMA folder location from
which the file is read. If the folder does not exist, the system creates it.

l Logs the attempt as an invalid format file
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Invalid Format
l Updates the import report to show that the file is an Invalid Format and was skipped
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Invalid Type - Not Imported

� Unreadable files
The system:

l Date-time stamps and copies the file to an Unreadable folder under the EVCMA folder location
from which the file is read. If the Unreadable folder does not exist, the system creates it.

l Logs the attempt as an unreadable file
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Unreadable
l Updates the import report to show that the file is Unreadable and was skipped
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Unreadable - Not Imported

View SQL importer log
The SQL importer log available to administrators provides better visibility into the nightly import process.
The SQL importer log records details about the last import that took place, including any errors, in an
easy-to-view format. Administrators can use this log as a diagnostic tool when errors occur because it is
more descriptive than the Axiom log.

The log records the following:

l SQL Import run ID number
l Task group ID
l Message – A brief description of the activity during each phase of the process
l Log Date/Time
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l Exception – Error and associated information
l Error – Error flag True or False; True indicates an error

To view the SQL Importer log:
In themain menu header, click Admin > SQL Importer log.
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Managing attributes
Attributes are custom tags that allow you to extend contract data models. Attributes allow you to add
information to a contract that exists on the physical contract but for which theremay not be room in the
modeled version.

l Attributes can be applied to claim and line-level reporting to enhance understanding of contracts
and calculation performance.

l Attributes provide a way for you to define, organize, and categorize all levels of a contract model.
l Attributes enhance the reporting and analysis of contract calculations.

Only users who have permissions to model contracts can add attributes to contracts.

As a system administrator, you create and manage system attributes on the Attributes page, accessible
from the Admin menu on themain toolbar.

Overview of Attributes page

3
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Creating attributes
Attributes available to you depend on the contract level you are at when you add the attribute. If you are
adding an attribute at the contract level, the only attributes available to select will be contract type
attributes. This means that when you create attributes, think about what kind of data the attribute
should hold, and at what level of the contract the attribute should be applied.

Only system administrators can create attributes.

� Create an attribute
Use these instructions to create attributes that do not contain libraries (i.e., a selection list).

To create a non-Library data type attribute:
1. In themain menu header, click Admin >Manage Attributes.

2. On the Attributes page, on the upper right, click Create New Record.

The Create newAttribute dialog opens.

3. In the Attribute name field, type a name for the attribute.

4. In the Attribute Description field, type a description for the attribute.

5. From the Attribute Data Type drop-down, select one of the following:

NOTE: You cannot change an attribute’s Data Type after saving the attribute.

l Integer – Creates a field that accepts a number
l Money – Creates a field that accepts dollar and cent amounts
l Decimal – Creates a field that accepts decimal values
l Percent – Creates a numerical field that accepts percentages
l Text – Creates a text field for the user to enter text
l Library – Creates a list from which a user can select values. To create this type of attribute,

see Create a Library attribute.

6. From the Attribute Type drop-down, select which part of a contract the attribute should be
applied to:

NOTE: You cannot change an attribute’s Type after saving the attribute.

l Contract
l Version
l Provision
l ClauseTerm

7. To make this attribute available for immediately after creation, verify that the Enabled check box
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is selected.

8. If you selected the Library attribute data type, click Save. When the page refreshes, click the Edit
Library button to the right of the grayed out Attribute Data Type field.

9. Do one of the following:
l To save but remain on this page, click Save.
l To save and exit this page, click Save and Close.
l To save and create another attribute, click Save and New.

� Create a Library attribute
Library data type attributes allow you to create a list users can select from when applying the attribute.

To create a Library data type attribute:
1. In themain menu header, click Admin >Manage Attributes.

2. On the Attributes page, on the upper right, click Create New Record.

The Create newAttribute form opens.

3. In the Attribute name field, type a name for the attribute.

4. In the Attribute Description field, type a description for the attribute.

5. From the Attribute Data Type drop-down, select Library.

6. From the Attribute Type drop-down, select the contract part the attribute should be applied to.

NOTE: You cannot change an attribute’s Type after saving the attribute.

7. To make this attribute available for selection immediately after creation, click the Enabled check
box.

8. Click Save.

The page refreshes to show an Edit Library button to the right of the Attribute Data Type field.

9. Click the Edit Library button.

10. In the Attributes Librarywindow, click Add new record.

11. In the Library Value field, enter the first item for the pick list in the field provided, then click
Update. The item is added to the list.

12. Click Add new record again to add a second item to the pick list. Enter the second item in the field
provided and then click Update. Repeat this step until you have added all the desired items.

13. Click the X in the upper right corner to close the window.

14. On the Edit Attribute page, click Save and Close to save and exit the page, or click Save and New
to save and then create another attribute.
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Edit or delete an attribute
Only System administrators can edit or delete attributes.

Editing includes:

l Changing attribute names and values,
l Disabling or enabling attributes
l Deleting attributes

NOTE: You cannot change an attribute’s Data Type or Type. However, you can edit pick list entries
for Library data type attributes.

To edit or delete an attribute:
1. In themain menu header, click Admin >Manage Attributes.

The Attributes page opens.

2. To edit an attribute, click the Edit button at the end of the attribute’s row and then do any of the
following:

l To disable an attribute so that it cannot be used, clear the Enabled check box.
l To change the name, in the Attribute Name field, type changes.
l To change the description, in the Attribute Description field, type changes.
l To change the pick list selections for a Library data type attribute:

a. To the right of the Attribute Data Type field, click the Edit Library button.
b. To edit an entry, click the Edit button for the entry, make desired changes, and then

click Update.
c. To add a new entry, click Add new record, and then enter a value, then click Update.
d. To delete an entry, click theDelete button for the entry, and then click OK in the

confirmation dialog.
e. Close the Attributes Library window.

3. To delete an attribute:

NOTE: The recommended best practice is to disable an attribute rather than deleting it.

a. Verify that the Enabled column is blank. If it reads “true,” then click the Edit button and
clear the Enabled check box, then save the attribute.

b. Verify that the attribute is not currently attached to any contract or contract items.

c. At the end of the attribute’s row, click theDelete button.

d. In theDelete confirmation dialog, click Yes.

4. Click Save.
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Managing insurance plan codes
As an administrator, you can manage insurance plan codes in your Axiom Contract Management
systems. Managing codes include creating new codes, searching for existing codes, and adding codes to
contracts.

Insurance plan codes are assigned to contract versions to determine which payers and procedures on
incoming claims apply to that version. New codes coming in on claims are automatically added to the
OrgCode PayerCode library. However, the new code will not cause the claim to trigger a contract until the
code is added to a contract version. As an administrator, you can assign a new insurance plan code to a
contract as soon as you become aware of it so that incoming claims calculate upon import instead of
waiting until the new payer code is assigned. Then, when the new code imports from a claim or an
AddPayer file, it is recognized as existing and not duplicated.

On the Insurance Plan Codes page, you can do the following:

l Add a new insurance plan code to the system
l Search for existing insurance plan codes using a variety of criteria

Create an insurance plan code
Use these instructions to add a new insurance plan code to your system if you know the payer code and
the organization.

To create a new insurance plan code:
1. In themain menu header, click Admin >Manage Insurance Plan Codes.

4
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2. On the Insurance Plan Codes page, on the upper right, click Create New Payer Code.

3. On the Create New Payer Code page, from theOrganization drop-down, select the applicable
organization.

4. In the Payer Code field, enter the code for the payer.

5. In the Payer Description field, type a description for the payer.

6. Do one of the following:
l To save and close the page, click Save and Close.
l To save the new code and continue working, click Save.

A green line appears briefly across the bottom of the page to indicate the code saved.

NOTE: If you see a red line across the bottom of the page when you save, it means that payer
code is already in use in the system. You will need to use a different payer code.

NOTE: Currently there is no delete function for removing an insurance plan code from the system. If
you create a code in error, assign it to a dummy contract to remove it from the available code listing.
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Search for an existing insurance plan code
If you do not see the insurance plan code you want to use in a selection menu, you can search for the
code to see if it exists. You can search on the following main parameters:

l Org code
l Organization
l Payer code
l Payer description

To search for an insurance plan code:
1. Navigate to the Insurance Plan Codes page:

l From the Admin menu, selectManage Insurance Plan Codes.
l From the Edit Versionwindow, in the Insurance Plan codes tab, click the Search icon ( ).

2. On the Insurance Plan Codes page, in the header of the column to search on, click the filter icon (
) at the right end of the column.

3. In the filter dialog, select the criteria to search on, and then click Filter.

The list is filtered to items that fit your search parameters.

4. If your search returned no results, try broadening the search criteria; for example, instead of “Is
equal to” try selecting “contains”.

5. To clear the search, click the filter icon again, and in the search dialog, click Clear.

6. If you have verified that the insurance plan code is not in the system, you can add it if you have
administrative rights.
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Map provider names to Org codes
Contract Management administrators can manage provider namemappings to organizational codes
using the Provider Org CodeMapping feature.

When a claim enters the system, the provider name on it is checked against the existing list of names. If
the name is different in any way from the names already in the list (for example, spelling or word order),
it is added to the list. Administrators can then map the new provider names or the name variances to the
correct Org codes.

By default, new provider names come in with the default code. You can select the desired name from the
Org Code drop-down or, if needed, you can create a newOrg code.

To map a provider name to an Org code:
1. In themain menu header, from the Admin menu, select Provider Org Code Mapping.

2. Locate the provider name in the list on the left. Names are listed in alphabetical order.

3. In theOrg Code column, from the Org code drop-down for the corresponding provider name,
select the desired Org code. The change is saved automatically. If the needed Org code does not
exist, you can add it using the following instructions.

4. To propagate the provider name and Org code association to existing claims, recalculate the
claims.
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To add a new Org code:
1. In themain menu header, from the Admin menu, select Provider Org Code Mapping.

2. In the Add New Org Code section, in theOrg Code field, type the number to associate with the
Org code.

3. In theDescription field, type the Org code description.

4. Click Save.
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Modeling contracts
Axiom Contract Management stores contract terms, patient claims, and payment information. The
system uses the contract payment terms and the patient claim information to calculate an expected
payment for every claim submitted by the provider. After the claim is paid by the primary payer, it can be
compared to the expected payment and/or the expected contractual to see if the claim was reimbursed
according to the agreed upon contract terms.

Contract data requirements
For expected payments to bemodeled accurately, the contract terms must be entered correctly in Axiom
Contract Management. To accomplish this, you need a thorough understanding of the contract
language and terms as well as access to electronic fee schedules, and any other data relevant to building
a model of the signed contract. For Medicare-based contracts, you need hospital-specific factors
provided to the hospital by either the Fiscal Intermediary (FI) or by CMS directly. Often this requires
direct contact with the payer representative.

You then need to interpret these terms into Axiom Contract Management, with the understanding that
Axiom Contract Management uses specific logic to calculate a claim. This logic is discussed in the rest of
this section on building contracts.

Filter contracts on the Contracts page
You can filter the list of contracts on themain Contracts page by contract name or by the latest
expiration date.

To filter contracts:
1. If the desired simulation is not currently selected, select it from the simulation drop-down:

5
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2. In the Contract Name column header on the right, click the Filter icon ( ).

NOTE: To filter by expiration date, click the filter icon in the Latest Expiration Data column
header.

3. In the filter dialog, from the drop-down, select the desired filter criteria. The default criteria is
“Contains.”

4. In the input field, type the item on which to search. For example, if you selected Contains as the
criteria, type the word or phrase contained in the contract name you are searching for.

5. Click Filter.

The filtered list displays contract names based on the criteria you specified.

6. To clear the filter, click the Filter icon again, and then click Clear.

Add a new contract
The following instructions are for creating a new contract from scratch.
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To add a contract:
1. On the Contracts page, verify that you are in the correct simulation. If you are not, then from the

simulation drop-down, select the desired simulation.

2. Under the Contracts page title, click Add a New Contract.

NOTE: The Add a NewContract option is displayed only if you have administrative access.

3. In the Add a New Contract dialog, in the Contract Name field, type a name for the contract (e.g.,
Medicare Blue Cross). Do not use special characters.

4. Click Save.

NOTE: You do not need to enter the latest expiration date because that is defined by the
versions built under the contract.

5. (Optional) If desired, add an attribute to the contract.

6. Next, add a version to the contract.

Add a version
After creating a contract, the next step is adding a version. Instead of names, versions are identified by
their active period, which is the time frame defined by their start and expiration dates. Versions are
assigned numbers that correlate to the version’s original start and expiration date period. Generally, the
older a version, the lower the number used to identify it. So, for example, version 1would be older than
version 2, and so on.

Use these instructions to add a new version to a contract. You can also copy a version by importing it
from another contract, or you can import a version from an external file.

To add a new version:
1. On the Contracts page, hover your cursor over the desired contract row to view theGo to

Versions link, then click the link.

TIP: If the list of contracts is long, find the desired contract by filtering the list.

2. On the Versions page, click Add a New Version.

3. In the Add a New Version dialog, in the Start Date field, type in the date or click the calendar icon
( ) and select the date on which the version takes affect.
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� About Start Date / Expiration Date
In Axiom Contract Management, a version represents a defined time frame for the contract. The
time frame used can be from the time period on a certain contract where the terms remain
consistent. It can represent the fiscal year, or it can represent the calendar year. To minimize the
number of contracts built, we recommend that you build versions defined by contract periods
where terms remain unaltered.

4. In the Expiration Date field, type in the date or click the calendar icon ( ) and select the date on
which the version’s active period ends.

5. In the Calculation Date field, select the calculation date for the version—either the date of
discharge or the date of admission.

� About Contract Calculation Date
You have two options when calculating claims: you can choose to calculate them by the date they
were admitted (Admit), or by the discharge date (Discharge).

The one you use depends on the payer, which you should confirm with them. The default is by
discharge date.

6. Click Save.

7. (Optional) If desired, add an attribute to the version.

8. (Optional) If desired, attach a document to the version.

9. Next, assign an insurance plan code to the version.

10. Add a provision to the version.

Import insurance plan codes to a version
When creating or editing a contract version, you can import insurance plan codes from another version.
The import feature imports copies of the insurance plan codes.

To import insurance plan codes to a version:
1. Navigate to the version to which you want to add codes.

2. At the end of the version row, hover your cursor and click the Edit icon ( ).

3. In the Edit Version dialog, click the Insurance Plan Codes tab.

4. In the lower half of the dialog, click the Import tab.

5. In the list of contracts, locate and expand the version that has the codes you want. To import a
code, click the arrow icon at the end of the code row, as shown in the following example:
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The code is copied to the Assigned section of the dialog.

6. Click Save

NOTE: If you copy a code you do not want, before saving, you can remove it by clicking
Remove icon ( ). To remove after saving, from the Assigned section, click the Unassign icon (
) for that code.

Add a provision
You can add a provision to a contract by creating a new one, by copying and editing an existing one, or
by importing one. Use the following instructions to create a new provision.

TIP: Use this option when there is no similar provision to copy or import.

To create a new provision:
1. Navigate to the desired contract version.

2. In the desired version row, click Go to Provisions.
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3. On the Provisions page above the table of provisions, click Add a New Provision.

4. In the Add a New Provision dialog, the Start Date and Expiration Date of the provision are
automatically set to match that of the version the provision is under. If you need to change the
dates, type in new dates or click the calendar icon ( ) and select the dates.

5. Click the Type of Bill tab.

Use this tab to select the Type of Bills that should calculate under the provision. For example, if
both the inpatient and outpatient contracts pay 75% of charge, you can create one contract
provision to handle both bill types. The provision’s purpose is to select the bill types that calculate
similarly under a specific date range.

6. In the Available section of the tab, click the plus icon to the left of the desired Type of Bill to
expand its codes, then select the bill codes to apply by clicking the Assign icon ( ) at the end of

the row for each desired bill code.
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NOTE: You cannot add attributes to the provision until you save it.

7. Click Save.

8. (Optional) If desired, add an attribute to the provision.

9. (Optional) If needed, add a schedule to the provision.

10. (Optional) If needed, add a modifier to the provision.

11. (Optional) If needed, add a global limit to the provision.

12. If needed, enter provision factors manually or import factors from a file or other provision.

13. Next, add a clause to the provision.

About bill types
The bill type, or Type of Bill (TOB), is a three-digit numeric code on a claim that identifies the specific type
of bill being sent to the payer. The first digit represents Type of Facility (Hospital, Skilled Nursing, etc.),
the second digit represents the Bill Classification (Inpatient, Outpatient, etc.), and the third digit
represents the Frequency (Admit/Discharge, Late Charges, Series, etc.).

The TOB submitted on the claim is important not only for determining the provision on which the claim
will calculate, but also for how the claim is handled during import. For every patient account, the
importing logic first checks whether the account already exists in the system. If it does, the system
applies a series of logical statements and the instance of the claim is brought in as Active, an Exception,
or a Voided Record. All claims are brought in as the Active claim if no other instance of the claim exists,
and as long as the claim is not a Late Charge (e.g., TOB XX5) or a Voided Record (i.e., TOB XX8).
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A Late Charge is always brought into the system as an Exception Record. If an active record exists for that
patient account, the late charge is attached to the active claim and the line items from the late charge are
appended to the active record. If no active record exists, the late charge claim sits idle as an Exception
until an active record is brought in for that particular account number. At that time, it appends to the
newly imported active claim.

Series TOBs (e.g., XX2, XX3 and XX4) are handled differently. If a Series Start bill (e.g., XX2) already exists
in the system and another is imported, the imported one becomes the newActive claim and the
previous instance is considered Replaced. The same applies to a Series End TOB (e.g., XX4). Multiple
Series Interim bills can exist on a claim; however, if an XX3 comes in and has the same admit and
discharge dates as a previous XX3 as well as the same total charges, it will replace thematching instance.

The standard Admit/Discharge claim (e.g., XX1) always comes in as active, and replaces the existing active
record as long as the charges are equal to or greater than the current record. The claim comes in as an
Exception if total charges are less than the existing claim. A Replacement claim (e.g., XX7) always replaces
the existing active record no matter what the total charges are for the claim, and regardless of whether or
not there are late charges appended to the current record.

Replacement and Late Charge claims are not allowed with Series claims. Both come in as Exception
records if a series TOB exists on the account. The reverse is true as well: Series claims are not allowed on
non-series accounts.

About provision factors
Provision factors are used in various CMS calculations. Certain factors, along with other contract rules
related to modifiers, are required for APC and eAPG contracts.

Some of the factors are considered National Factors (e.g., Labor Related Standard Amount, Federal
Capital Rate, etc.), which means that they are the same across the nation. Some factors are Hospital
Specific and can only be answered by the hospital’s Medicare Specialist to whom notices are sent when
the factors are changed, or when a new fiscal year begins and all factors have changed. Any field labeled
“Release” cannot receive a manual entry; instead, it will be updated when rates are attached to the
clause or term.

To use any CMS-related calculation basis (e.g., CMS DRG, CMS Psych, CMS CMG, or Schedules related to
CMS), you must complete the factor forms. You can add the following types of provision factors:

l CMS DRG – Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient services that are paid using a code called a DRG.

l CMS CMG – Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient Rehab services.

l CMS Psych – Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient Psych services.
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l Schedules – Select 3M schedules for outpatient services that are paid with APC or eAPG. These
schedules contain the hospital-specific and federal values appropriate for the date range of the
provision.

l Modifiers – Enter modifier values used in line-level calculations within the provision. Lines with
modifier codes are calculated using these values. Four functions are allowed with modifiers:
addition, subtraction, multiplication, and division.

For instructions on adding CMS factors to provisions, see the following:
l Manually enter CMS DRG provision factors
l Manually enter CMS CMG provision factors
l Manually enter CMS Psych provision factors
l Import and export provision factors

Assign a schedule to a provision
Use these instructions to assign a schedule to a contract provision. A schedule is a reference from the 3M
Grouper that is used for calculating outpatient APCs and eAPGs for a variety of contracts. Schedules are
required when you model contracts having APC or eAPG reimbursement for outpatient services.

To assign a schedule to a provision:
1. Navigate to the desired provision.

2. In the Schedule column for the provision, click the Edit icon ( ).

3. In the Edit Schedule dialog, from the Select a Reimbursement Type drop-down, select the kind of
reimbursement the provision uses. This selection determines the schedules available in the next
drop-down.

4. From the Select a Schedule drop-down, select the desired schedule.

5. Click Save.

Manually enter CMS DRG provision factors
Use these instructions to add CMS DRG provision factors used when calculating Medicare Inpatient
services.

To add CMS DRG factors to a provision:
1. Navigate to the desired provision.

2. On the Provisions page, in the CMS DRG column for the desired provision, click the Edit icon (

).

3. In the Edit Factors dialog, in the Settings tab, enter amounts in the fields provided, as needed.
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NOTE: Fields with names in blue indicate they are required for calculated payment. Fields with
names preceded by a red percent sign (%) require you to enter the percentage amounts as
decimals.

4. If needed, assign transfer codes:
a. Click the Transfer Codes tab.

b. In the Available Codes section, locate the desired code in the list.

c. On the right end of the list, click the Assign icon ( ) to move the selected code to the

Assigned Transfer Codes section.

5. Click Save.

6. If needed, add outlier exclusions.

Import and export provision factors
When copying or creating contract provisions, you can import CMS DRG, CMS CMG, or CMS Psych
factors from a file or from another provision instead of populating the factors fields manually.
Additionally, you can export factors to an Excel file.

� Import provision factors from another provision
To import provision factors from another provision:

1. Navigate to the provision needing factors.

2. In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon ( ).

3. In the Edit Factors dialog, click the Import tab.

4. In the Import tab, do the following:
a. If needed, from the Simulation drop-down, select the desired simulation.

b. Expand the contract and version with the desired provision and factors.

c. In the Provision list, for the desired provision, click the import factors icon ( ).
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The Factors dialog opens, displaying the imported factors.

5. In the Factors dialog, click Save.

� Import provision factors from a file

NOTE: Excel files used to import factors need to adhere to a specific format. To ensure your file is
formatted correctly, download the template and enter or copy the desired factor information to it,
then save and import it using the following instructions.

To import provision factors from a file:
1. Navigate to the provision needing factors.

2. In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon ( ).

3. In the Edit Factors dialog, click the Import tab.

4. In the Import tab, do the following:
a. Click the Import From File tab.

NOTE: The imported factors file must adhere to the factors template.

b. If needed, on the right side of the dialog just above the Import button, click the download
icon ( ) to download the template. Complete the information in the template, then

name and save it. Or, you can import factors that you exported from another provision to
an Excel file provided the file matches the factors template layout.

c. On the left of the dialog, do one of the following:
l Click Select files... and then select a file or files to import.
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l Drag and drop the desired files to the gray area marked Drop files here to upload.

d. Click Save.

The factors display in the corresponding CMS tabs for the type(s) of factor(s) imported.

5. In the Factors dialog, click Save.

� Export provision factors to an Excel file
To export provision factors:

1. Navigate to the provision with the factors to export.

2. In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon ( ).

3. In the Factors dialog, at the bottom, click Export.

The data is exported to an Excel file at the bottom of your screen. Data is exported from all three
CMS tabs. If no data exists for a particular column, then in the Excel file, that tab displays with
headings only but no data. The file is automatically formatted correctly for importing to another
provision.

4. If desired, click the file to open and view it.

Select outlier exclusions

� About modeling changes to the inpatient CMS DRG calculation
To accurately model changes made to the Inpatient CMS DRG calculation, you may need to determine
the high-dollar outlier exclusion amount. To exclude high-dollar charges like transplant acquisition
charges or coagulation factors from the CMS DRG outlier determination, you can specify the Line Item
Codes or Rev Codes associated with these charges to exclude them from the outlier determination within
the CMS DRG calculation. Use the Exclusions tab when defining a provision for Medicare and Medicare-
like contracts.

After selecting the exclusions, you add a clause or term with the CMS DRG calc basis, and then attach
DRGs and other required DRG-related elements. When incoming claims are processed against the CMS
DRG calculation, if a claim has any CMS DRG items that match the clause or term on the provision, the
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system inspects the lines on the claim for the selected exclusion codes. The system totals any claim items
that match the exclusion codes and then subtracts this amount from the total charges when determining
the outlier portion of the CMS DRG calculation.

To specify outlier exclusions:
1. Navigate to the desired provision.

2. On the Provisions page, in the CMS DRG column for the desired provision, click the Edit icon (

).

3. In the Edit Factors dialog, click theOutlier Exclusions tab.

4. At the top of the tab, select the exclude option:
l Rev Code – Select exclusion items by revenue code.
l Line Item Code – Select exclusion items by line item code.

5. In the lower half of the tab, locate the item(s) to exclude, and then click the Assign icon ( ) to the

right of each item to move that item to the top half of the tab.

6. Click Save.

Using attributes
Users who have permissions to model contracts can add attributes to contracts.
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Attributes are custom tags that you add to contracts and contract levels (i.e., versions, provisions, and
clauses/terms) to:

l Extend the contract data model – Attributes allow you to add information to a contract that exists
on the physical contract but for which theremay not be room in themodeled version.

l Organize key aspects of payer contracts
l Enhance reporting across contracts and payers by
l Augment reporting for current calculations and modeling detail
l Ensure key details are collected during contract building

Attributes can be applied at all contract levels: contract, version, provision, clause and term. You can
apply an attribute from the list of attributes for that contract level or you can import an attribute from
another contract at the same level. Contract levels with applied attributes display a circled with check

mark icon ( ) in their Attributes column.

Attribute data:

l Name – Attribute name
l Description – Explanatory information about the attribute
l Data Type – The format of the attribute’s data value (e.g., text, integer, percent, etc.). For

example, if the Data Type is text, then the attribute’s value field accepts only text entries. The
following are the data types for attributes:

o Integer – Accepts a number
o Money – Accepts dollar and cents amounts
o Decimal – Accepts decimal values
o Percent – Accepts percentages
o Text – Accept text
o Library – A drop-down list from which you select a value for the attribute

l Attribute Type – The contract level at which the attributed can be used (i.e., contract, version,
provision, clause/term)

l Enabled/Disabled –Whether or not the attribute is available for use. If an attribute is disabled by
the system administrator, it will not display in any attribute selection lists.

Add an attribute to a contract level
You can add attributes to contracts at each level: contract, version, provision, and clause/term. When
adding attributes, you can add only attributes of the type that corresponds to the contract level. For
example, you can add only version attributes to versions, and clause/term attributes to clauses or terms.

To add an attribute to a contract level:
1. Navigate to the desired contract level.
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2. At the end of the contract/version/provision/clause or term row, hover your cursor, and then
click the Edit icon ( ).

3. In the Edit [contract level] dialog, click the Attributes tab.

4. In the Attributes section, for the desired attribute, select the attribute value from the Attribute
Value field.

Attribute values depend on the attribute’s data type (e.g., text, integer, percent, etc.).

Attribute Data
Type

Selection process

Library Select from a drop-down list of options

Text Input the desired text

Decimal Click the arrows to indicate the number of decimals

Integer Click the arrows to indicate the number of integers

Money Click the arrows to indicate the amount ofmoney

Percent Click the arrows to indicate the percentage.

In the following example, to add the contract attribute Color, select the desired color from the
drop-down.

5. Click Save.

Import an attribute to a contract level
Use these instructions to add attributes to contracts by importing them from other contracts. When you
import an attribute, the system copies the attribute from the source and applies the copy to the target
contract level.
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� Import an attribute to a contract
1. Navigate to the contract that needs the attribute.

2. At the end of the contract row, hover your cursor, and click the Edit icon ( ).

3. In the Edit Contractwindow, click the Attributes tab.

4. In the Import Attributes section, verify that displayed simulation is the one with an attribute you
want to use. If not, then from the Simulation drop-down, select the desired simulation.

5. In the list of contracts, locate and expand the level that has the attribute you want.

NOTE: Only contract-level attributes will be included in the list to choose from.

6. To import the attribute, click the Assign icon ( ).

7. Click Save.

� Import an attribute to a version, provision, clause, or term
1. Navigate to the contract level needing the attribute.

2. At the end of the version/provision/clause/term row, hover your cursor and click the Edit icon (
).

3. In the Edit [contract level] dialog, click the Attributes tab.

4. Across from the Import Attributes section title, from the Simulation drop-down, select the
desired simulation.

5. In the list of contracts, expand the desired contract levels to reach the desired level and then
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expand that level item. For example, if you are importing attributes for a clause, navigate to the
desired clause and then expand the clause to view its attributes.

6. Do one of the following:

l To import all of the [contract level]’s attributes, click the Assign icon ( ) at the end of the
row.

l To import selected attributes, click the Assign icon ( ) for the desired attributes.

Example of version-level attribute list

7. Click Save.

Modeling clauses and terms
Clauses and terms are provision building blocks; they are the vehicle that defines contract terms, rates,
and limits. A clause and term are interchangeable in how they calculate; however, a term always resides
beneath a clause. The clause is considered the parent of the term. A clause can have no terms or it can
havemultiple terms. A term always has the one clause under which it resides. The order and the
selections made on a clause/term determine how the claims filter through the calculation criteria.

� Clause and term order significance
Axiom Contract Management calculates claims in a top-down manner for both clauses and terms. This
means that a claim initially tries to match to the first clause listed in the provision. If there is no match, it
continues on to the next clause, regardless of whether or not a term exists on clause 1. If, on clause 2, the
claim matches the defined criteria, it stops and makes the calculation. Then it continues on to the first
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term of the clause (if it exists), and then the second term (again, if it exists) beforemoving on to clause 3,
and so on. The only way to stop a claim from moving to the next clause (or term) is to set it as terminal.
For information on changing the order of a clause or term, see Edit or delete a clause or term.

� Clause or term Calc Basis
The following example shows some of the possible selections for the clause/term calculation basis. You
cannot edit these. The calculation basis is used in conjunction with the calculation type and measure to
determine a specific reimbursement method.

The Calc Basis paired with the rates loaded for the clause or term determine whether a claim will qualify.
For example, if you select Admit Diagnosis Code, Axiom Contract Management only finds claims for
which the defined clause/term codes match the admitting diagnosis code on a claim.

The CMS-based options include specially built calculation rules that are used with the defined factors for
the provision.

Certain calc basis options are considered claim level and some are considered line item level. Selecting
one or the other determines the options available for Calc Type and Calc Measure. For example, DRG is
considered claim level, whereas RevCode is considered a line item level calculation basis.

Example of Calc Basis column in list of clauses

� Calc Type
There are three possible selections for the Calc Type field. Either the clause/term will be paid at a Dollar
Rate, a % of Charge, or a % of Cost, with the first two selections being themost commonly used. The calc
types available for selection are determined by the Calc Basis selected.
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� Calc Measure
The five possible selections for the Calc Measure field are: Per Claim, Per Diem, Per Date, Per Line Item,
and Per Line Item Qty. These options are limited based on the calc basis selected for the clause/term. For
example, if DRG is selected as the calc basis, the option for Per Date, Per Line Item, and Per Line Item Qty
are not applicable because those are used with line item level parameters only.

� Terminal vs. Non-terminal
Setting a clause or term as terminal or non-terminal (the default) determines if a claim will continue
calculating on the clause or term below it.

Setting a clause to Terminal (i.e., Yes) stops the claim from progressing to the next clause; it does not
stop it from moving through all of the terms (if any) below that clause.

Setting a term to Terminal stops it from progressing to the next term under the same clause; it does not
stop it from moving through any clauses (if any) below it. For the terminal logic to apply to a claim, it
must qualify on the defined calculation criterion for the clause or term.

For example, if a claim has an implant revenue code, a certain dollar amount will apply to that rev code
line item for all claims, and even if a claim qualifies for this payment, it will continue down to the next
clause. If the claim qualifies for Orthopedics, it stops there, and Orthopedics will be the only other
possible payment method on the claim, as that is a terminal clause. If it is not an Orthopedic claim (based
on the defined DRG), it will continue on. If a claim qualifies on Clause 8Med/Surg, it could also qualify
and reimburse on Clause 9 ICU, as that is a non-terminal clause.

Example Clauses/Terms page with Terminal column outlined in red

Navigating in contracts
Contract pages in Axiom Contract Management are laid out in a simulation-to-term hierarchy, with the
simulation name at the highest level, and terms (unless the final clause has no terms) at themost
granular:

Administrator's Guide Axiom Contract Management │ 65



l Simulation >
o Contract >

o Versions >
o Provisions >

o Clauses >
o Terms

Drill through each level to reach the one below it. As you move through the contract levels, breadcrumbs
display at the top of the page.

To navigate to different contract levels:
l To navigate to versions, from the Contracts page, for the desired contract, hover your cursor in

the contract row, and then click Go to Versions.

l To navigate to provisions, from the Versions page, for the desired version, click Go to Provisions.
l To navigate to clauses, from the Provisions page, for the desired provision, click Go to Clauses.
l To navigate to terms, from the Clauses page, for the desired clause, click Go to Terms.
l On the Terms page, or any page in between, you can backtrack to previous pages using the linked

breadcrumbs at the top of the page. Click the link to go back to the desired page.

When you backtrack, the page you backtracked from is removed from the breadcrumb trail.

Add a clause to a provision
When creating a clause, you need to define the services being reimbursed and their contracted rates. For
this, you select the calculation criteria. (For information on Calc Basis, Calc Type, Calc Measures, and
Terminal vs. Non-terminal, seeModeling clauses and terms.) You can also add attributes to a clause.
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To add a new clause:
1. Navigate to the desired provision.

2. On the Provisions page, in the desired provision row, click Go to Clauses.

3. On the Clauses page above the table of clauses, click Add a New Clause.

The Add a New Clause dialog opens.

NOTE: The clause number is assigned by the system and cannot be edited initially, but after
creating the clause and saving it, you can move it to a different position in a group of two or
more clauses on a provision.

4. From theDescription drop-down, do one of the following:

l Select a description for the clause.

TIP: In drop-downs with numerous results, like Description, you can search for a specific
result: click in theDescription field and begin typing a search word. Matches display in
the drop-down results; click a description to select it.

l Add a new description: click theDescription field name, which is linked to the Clause/Term
Descriptions page where you can add a new description if you are an administrator.

5. From the Calc Basis drop-down, select the basis for calculation.

6. If applicable (depends on the selected Calc Basis), from the Calc Type drop-down, select the
calculation type.

7. If applicable, from the Calc Measure drop-down, select themeasure on which the calculation is
made (for example, Per Claim, Per Line Item, Per Diem).

8. From the Terminal? drop-down, select Yes for Terminal orNo for non-terminal.

9. Do one of the following:
l To add rates, continue to step 10.
l To add thresholds, skip to step 11.

10. To add rates, do one of the following:
l For a single rate, type the rate into the Rate field.

NOTE: Some calculation bases and their associated calculation types and measures
require multiple rates or rates from an uploaded file. When this occurs, the Rate field is
inactive.

l For multiple rates, enter rates manually or import rates from a file.

Administrator's Guide Axiom Contract Management │ 67



NOTE: The Include clause in Global Limit check box is enabled automatically if the parent
provision contains a global limit.

11. To add thresholds, do one of the following:

l Add thresholds manually.
l Import thresholds.

NOTE: Not all calculation bases allow thresholds. For more information, see About
Thresholds.

12. Click Save.

13. (Optional) Add an attribute.

14. If needed, add a limit.

Add a term to a clause
A term always resides beneath a clause. The clause is considered the parent of the term.

When creating terms, you need to select the calculation criteria. For information on Calc Basis, Calc Type,
Calc Measures, and Terminal vs. Non-terminal, seeModeling clauses and terms.

To add a new term:
1. Navigate to the desired clause.

2. In the row for the desired clause, click Go to Terms.

3. On the Terms page, above the table of clauses, click Add a New Term.

The Add a New Term dialog opens.

NOTE: The term number is assigned by the system and cannot be edited initially, but after
creating the term and saving it, you can move it to a different position in a group of two or
more terms on a clause.

4. In theDescription drop-down, do one of the following:

l Select a description for the term.

TIP: In drop-downs with numerous results, like Description, you can search for a specific
result: click in theDescription field and begin typing a search word. Matches display in
the drop-down results; click a description to select it.

l Add a new description: click theDescription field name, which is linked to the Clause/Term
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Descriptions page where you can add a new description if you are an administrator.

5. From the Calc Basis drop-down, select the basis for calculation.

6. From the Calc Type drop-down, select the calculation type.

7. If applicable, from the Calc Measure drop-down, select themeasure on which the calculation is
made.

8. From the Terminal? drop-down, select Yes for Terminal orNo for non-terminal.

9. To add rates, do one of the following:
l For a single rate, type the rate into the Rate field.

NOTE: Some calculation bases and their associated calculation types and measures
require multiple rates. When this occurs, the Rate field is inactive.

l For multiple rates, enter rates manually or import rates from a file.

10. Click Save.

Managing clause and term descriptions
The description is the first criterion that you need to define for a clause or term. A few standardized
descriptions are already included with the initial Axiom Contract Management installation, but you can
add, edit, and delete descriptions at any time.

Clause and term descriptions are available in all simulations.

� Add a new clause or term description
To add a new description:

1. In themain menu header, click Admin >Manage Clause/Term Descriptions.

The Clause/Term Descriptions page opens.

2. In the upper right corner of the page, click Create New Record.

3. On the Create New Clause/Term Descriptions page, in theDescription field, type the description.
The field has a 50-character limit.

4. Do one of the following:
l To save and return to themain Clause/Term Descriptions page, click Save, and then, in the

upper right corner of the page, click Back to Descriptions.
l To save and close the page, click Save and Close.

The new description is now available from the Description drop-down when you or others are adding or
editing clauses and terms.
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� Edit or delete a clause or term description

IMPORTANT: If you change a description, the change will be reflected in all accounts and data where
the description is used.

To edit a description:
1. In themain menu header, click Admin >Manage Clause/Term Descriptions.

The Clause/Term Descriptions page opens.

2. In the list of descriptions, locate the desired description. If needed, click the Filter icon ( ) and

filter the list.

3. At the end of the description row, click Edit.

The Edit Clause/Term Descriptions page opens

4. In theDescription field, make the desired change.

5. Do one of the following:
l To save and return to themain Clause/Term Descriptions page, click Save, and then, in the

upper right corner of the page, click Back to Descriptions.
l To save and close the page, click Save and Close.

To delete a description:
1. In themain menu header, click Admin >Manage Clause/Term Descriptions.

The Clause/Term Descriptions page opens.

2. In the list of descriptions, locate the desired description. If needed, click the Filter icon ( ) and

filter the list.

3. At the end of the description row, click Delete.

4. In the confirmation dialog, click OK.

Edit or delete a clause or term
You can make the following changes to a clause or term:

l Change the description
l Change the calculation basis, calculation type, and calculation measure, where applicable
l Change the terminal setting
l Add or remove attributes or change attribute values
l Add or remove attached rates

To edit a clause or term:
1. Navigate to the desired clause or term.
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2. At the right end of the clause or term row, hover your cursor and click the Edit icon ( ).

3. Do any of the following as needed:

NOTE: The term number is assigned by the system and cannot be changed.

l To change the description, from theDescription drop-down, select a different description.

NOTE: Administrators can add a new description.

l To change the calculation basis, type, and measure, select from the corresponding drop-
downs. Calculation type and measuremay or may not be changeable depending on the
calculation basis selected.

l To change the terminal setting, select from the Terminal drop-down.
l To change the rates, in the Rate field, type a new rate. If needed, import a rates file.
l To change attributes, click the Attributes tab and add, import, edit, or remove attributes.

4. Click Save.

To delete a clause or term:
1. Navigate to the desired clause or term.

2. At the end of the row for the clause or term, hover your cursor and click the Delete icon ( ).

3. In the Confirmation dialog, click OK.

Manually add rates to a clause or term
Use these instructions when you need to manually add rates to a clause or term. You can also import the
rates from a file instead of adding them manually if you prefer or if you have a page or more of rates.

To manually add rates to a clause/term:
1. Navigate to the desired clause or term.

2. In the Rates column, click the Edit icon ( ) (if no rates are attached, the icon will be grayed out).

3. In the Edit Rates dialog, click Add a New Row. A new row displays in the Rates Data View tab on
the left, as shown in the following example:
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4. In the Code field, type a code associated with the chosen calculation basis for the clause/term. (To
see the calculation basis, open the Edit Clause/Term dialog and view the Calc Basis field.) The code
description will autopopulate. If no description is associated with the code, it will read “NO
DESCRIPTION,” and will be selected so you can enter a description manually.

IMPORTANT: Once you save the description, you cannot change it.

5. In the Rate field, type a corresponding rate.

6. Add more rate rows as needed. To apply the same rate to multiple codes, see the following step 7.

7. (Optional) To apply the same rate to some or all the entered codes, or to adjust some or all of the
rates by a specific factor:

a. On the left, select check boxes for the rate rows to affect.

b. At the bottom of the dialog, from the Adjust selected rows drop-down, do one of the
following:

l Set rate equal to – To set all checked rows to the same rate, in the field to the right
of the drop-down, enter the desired rate.

l Factor rate by – To adjust all checked rows by an entered value, enter the
adjustment percentage as a decimal value (for example, enter 1.02 to increase the
set rate 2%),

c. Click Apply.

8. (Optional) To delete a rate, select the check box for that row, and then at the bottom right of the
dialog, click Delete Selected. In the confirmation dialog, click OK.

9. Click Save.

Import rates for a clause or term
When working with large fee schedules, or when working with certain calculation bases, manually
entering rates may not be feasible or allowed. In such situations, you can import the fee schedule or
rates table from an Excel file. If you are also importing translation tables, you should import those before
you import rates.
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IMPORTANT: There aremany types of rate files (DRG, Line Item Code, Rev Code, etc.). When
importing rates, make sure the rate file you upload matches the specific type of calculation basis
used by the clause or term. For example, if the clause or term uses CMS DRG, then a DRG rate file
that has a dollar rate would use these options: Calc Basis = DRG; Calc Type = Dolar Rate; Calc Measure
= Per Claim.

When importing rates, you first upload the rate file to the server, and then you attach it to the contract.

To import the rates:
1. Navigate to the clause or term needing rates.

2. In the Rates column of the clause/term row, click the Edit icon ( ).

3. In the Edit Rates dialog, click the Files tab.

4. On the left side of the dialog, the Rates folder under the calculation basis for the clause/term
should be selected as the destination of the rates file to be imported. If it is not, select it.

5. On the right side of the dialog, in theUpload files to a selected folder area, do one of the
following:

l Drag and drop the rates file.
l Click Select files and then select a rates file.

6. Click Upload. The uploaded file displays on the left under the destination folder, as shown in the
following example:
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7. Select the uploaded file.

8. (Optional) To rename, the file, on the right side of the dialog, the file name displays in the Rename
a selected file field. If desired, rename the file and then click Rename.

9. On the right side of the dialog, click the Specify tab. The top part of the tab displays an image
corresponding to the data in the uploaded file.

10. On the lower right of the dialog, in the Excel Column, for each row in the Rates Column, select
from the drop-down the letter that corresponds to the column in the image above. In the
following example, Code corresponds to column A in the Rates file. Do this for each field in the
Rates Column that needs to bemapped.
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11. For Excel data has column headers? select the appropriate option.

12. Click Save specifications.

13. Click the Import tab.

14. If needed, from the File Type drop-down, select Rates.

The file you uploaded displays under Specified Rates Files.

15. On the right side of the dialog, click Attach. When the file is attached, the check box displays
checked:
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16. To view the imported rates, click the Rates tab.

17. Close the Edit Rates dialog.

Import translation tables
Translation tables are crosswalk code tables that map equivalent, identical, or similar information across
two or more distinct data sets. Most crosswalking is done between a newer version and an older, out-of-
date version of the same code set. Certain Contract Management calculation bases, such as the
following, all require translation tables:

l Line Item Code Incidental
l RevCode Incidental
l Line Item CodeMPR
l Line Item Code ASC
l Multi-Channel Discount

If you select any of these calculation bases, the Edit Rates dialog will contain a Translation Data tab in
addition to the other tabs.

Importing translation tables follows the same basic process as importing rate files.

To import a translation table:
1. Navigate to the clause or term.

2. In the Rates column, click the Edit icon ( ) (if no rates are attached, the icon will be grayed out).

3. In the Edit Rates dialog, click the Files tab.

4. On the left side of the dialog, the Translation Tables folder under the calculation basis for the
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clause/term should be selected as the destination of the translation file. If it is not, select it.

5. On the right side of the dialog, in theUpload files to a selected folder area, either drag and drop
a translation table file to this area or click Select files and select the file to upload.

6. Click Upload. The name of the file displays under the folder on the left side of the dialog.

7. Select the uploaded file.

8. (Optional) To rename, the file, on the right side of the dialog, the file name displays in the Rename
a selected file field. If desired, rename the file and then click Rename.

9. On the right side of the dialog, click the Specify tab. The top part of the tab displays an image
corresponding to the columns and rows in the uploaded file.

10. In the lower right of the dialog, in the Excel Column, for each row in the Rates Column, select
from the drop-down the letter that corresponds to the column in the image above. In the
following example, column A corresponds to the Line Item Code column in the translation tables
file, and column B corresponds to ASC. Do this for each field in the Rates Column that needs to be
mapped.

11. Select whether or not the file uses headers, and then click Save Specifications.

12. Click the Import tab. If needed, from the File Type drop-down, select Translation Tables.

Administrator's Guide Axiom Contract Management │ 77



The translation table file should display under Specified Translations Files.

13. On the right side of the dialog, click Attach. When attached, the check box to the left of the listed
file displays as checked.

14. To view the uploaded data, click the Translation Data tab.

15. Close the Edit Rates window.

Attach or re-attach a file
Sometimes you need to attach multiple files; for example, if a clause or term has multiple Rev Code
calculation bases. While you can upload more than one file of a kind (e.g., rates, translation, etc.), only
one of those file types can be attached to the clause or term at a time. So, if a clause has a calculation
basis that requires a rates file and a translation data file, you can attach only one of each kind to the
clause at a time. When you attach a different file of the same type, the data in the new file replaces
previous data stored in the clause/term.

If you accidentally attach the wrong schedule or other file, or want to use a previously uploaded file, do
the following:

1. In the Edit Rates dialog, after uploading the desired file, click the Import tab.

2. If needed, from the File Type drop-down, select the file type.

3. In the Specified [type] Files section, do one:
l To use the original file, click Reattach.
l To use the newly uploaded file, click Attach.
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NOTE: To add additional rates, there are two options: 1) Upload, specify and attach a new file that
includes all rates required for the clause/term, or 2)manually add the new codes and rates.

IMPORTANT: Be aware that if a rate file is re-attached, any rate codes added manually will be
replaced by what is in the file.

View rates for a clause or term
A clause or term may have a single rate, multiple pages of rates, or a set of tiered rates, depending on the
service or procedure; or group or combination of services/procedures, contract type, provision, and so
on.

If a clause or term has a single rate, the rate displays in the Rate field of the Edit Clause (or Edit Term)
dialog.

If a clause or term has multiple rates or a set of tired rates, the Rates are displayed in the Edit Rates
dialog. The Edit Rates dialog also displays associated information and any attached files, if applicable.

To view the rates associated with a clause or term:
1. Navigate to the desired clause or term.

2. On the Clauses/Terms page, look in the Rates column.

l If the clause/term has a single rate, the Edit icon is grayed out ( ). To view the single rate,
at the end of the row, click the Edit icon ( ), and then, in the Edit Clause/Edit Term

dialog, look in the Rate field.
l If the clause/term has multiple or tired rates, the Edit icon is not grayed out. Click the Edit

icon. In the Edit Rates dialog, rates are displayed in the Rates tab.
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Example of Rates dialog for a clause with multiple procedures and rates

Copy a clause or term
Use these instructions to copy a clause or term to the same contract. To copy a clause or term to a
different contract, you need to copy the provision it is attached to.

To copy a clause or term:
1. Navigate to the clause or term to be copied.

2. At the end of the row, hover your cursor and click the Clone icon ( ).

The Clone Clause or Clone Term dialog opens.

3. At the bottom of the dialog, clear any check boxes for items that you do not want to copy from
the original clause or term.

Administrator's Guide Axiom Contract Management │ 80



NOTE: As stated at the bottom of the dialog, you must save the copy before you can edit the
rest of the settings.

4. Click Save.

5. (Optional) Edit the new copy as desired. For example, you may want to give the copy a different
description.

Set up post-grouper custom pricing
Some stateMedicaid and commercial Medicare-like plans useMedicare grouping methodologies but
then override some of the reimbursement rules for certain status indicators or APC codes. Or, they
simply pay at a percentage aboveMedicare. For claims reimbursement, you need to be able to model
these kinds of adjustments.

NOTE: These instructions do not apply to actualMedicare contracts, only Medicare-like contracts
from commercial plans.

When modeling contracts for commercial Medicare-like plans that use customized Medicare grouping
methodologies, you can include adjustments to the CMS Outpatient calculation. For example, you can
set rates for clauses and terms that use the CMS Outpatient calculation basis and adjust those rates as
needed.

During the CMS Outpatient calculation, the system receives the results from the 3M grouping and pricing
process and pulls the results into the voucher. You can adjust the voucher results as necessary for
payment in the following ways:

Administrator's Guide Axiom Contract Management │ 81



l Adjust the CMS Outpatient calculation basis in the Rates window:
o No Adjustment – No adjustment is made to the rates coming from the grouping and

pricing process. This is the default selection.
o Overall Percentage – Adjust the post-grouping and pricing rate by a specified percentage.
o APC Status Indicator – Adjust the calc basis based on the SI.
o APC code adjustment – Adjust the calc basis based on the APC code.
o Line-item code adjustment – Adjust the calc basis based on the line-item code.

Adjust rates for a CMS Outpatient calculation

Use these instructions to modify rates for a CMS Outpatient calculation basis on a clause or term, as part
ofmodeling post grouper custom pricing.

To set up post-grouper custom pricing on a contract:
1. Navigate to the desired clause or term with a CMS Outpatient calculation basis.

2. In the Rates column for the clause/term, click the Edit icon ( ).

3. In the Edit Rates dialog, in the Adjustments tab, select the type of adjustment:
l No Adjustment – No adjustment is made to the rates coming from the grouping and

pricing process. This is the default selection.
l Overall Percentage – Adjust the post-grouping and pricing rate by a specified percentage.
l APC Status indicator – Adjust the calc basis percentage based on the Status Indicator.
l APC – Adjust the calc basis percentage based on the APC groupings.
l Line Item Code – Adjust the calc basis percentage by specific line items on a claim.

4. Do one of the following, depending on your selection in the previous step:
l If you selected Overall Percentage, then in the Adjustment field, enter a percentage

written as a decimal value (e.g., 0.07), and then click Save. Skip to step 14.
l If you selected APC Status Indicator, APC, or Line Item Code, proceed to step 5.

5. Click the Files tab.

On the left side of the dialog, the folder corresponding to the selected type of adjustment is
selected as the destination.

6. On the right side of the dialog, in theUpload files to a selected folder area, do one of the
following:
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l Drag and drop the rates file.

l Click Select files, and then select the desired file.

7. Click Upload. The uploaded file displays under the folder on the left side of the dialog.

8. On the left, select the uploaded file. On the right side of the dialog, click the Specify tab.

9. The top part of the tab displays an image corresponding to the data in the uploaded file. On the
lower right of the dialog, in the Excel Column, for each row in the Rates Column, select from the
drop-down the letter that corresponds to the column in the image above. In the following
example, APC Status Indicator corresponds to column A in the Rates file. Do this for each field in
the Rates Column that needs to bemapped.

NOTE: Some files may contain fields that do not need to bemapped, or may not contain data
for an optional field; however, if you try to save the file without mapping a critical field, the
save will not work. In the following example, “Description” is not considered a critical field, so
saving without mapping this field works.
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10. For Excel data has column headers? select the appropriate option.

11. After mapping, click Save specifications.

12. Click the Import tab.

13. From the File Type drop-down, select the file type. The file you uploaded should display under the
gray header. On the right, click Attach.
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After attaching, the file’s check box displays as checked.

14. Close the Edit Rates dialog.

Using thresholds
A threshold is a specific type of calculation that can be placed on either a clause or a term within a
contract. Thresholds are used in situations where additional criteria, not just the code, is needed to
qualify the service for reimbursement. For example, the payor may require that the Total Charges of the
claim exceed a certain amount in order to qualify for additional reimbursement. Or, theremay be
different rates payable depending upon howmany days a patient is in the hospital.

NOTE: Clauses and terms can have either rates or thresholds, but not both.

A threshold’s parameters are defined by a Thresh Basis. A Thresh Basis a type ofmeasurement used to
define the tiers or levels of reimbursement within a threshold calculation. It is used in conjunction with
both a Lower Bound and an Upper Bound to make a claim qualify for the clause/term. A Thresh Basis can
be either claim-based (for example, Total Claim Days or Total Claim Charges), or line item-based (Total
Line Charges/Units or Total Daily Line Charges/Units). Not all calculation bases allow thresholds. For
example, Line Item ASC and Line Item MPR do not allow thresholds.

� Using calculation bases, measures, and types in thresholds
The Calc Basis, Calc Measure, and Calc Type, selected based on standard contract modeling rules, define
how the claim pays on the clause or term if the Thresh Basis Lower Bound and Upper Bound criteria are
met. As in normal contract modeling rules, the Calc Basis is used to determine if a claim qualifies for the
clause or term. The Calc Measure and Calc Type combined define how the claim is paid.

The following table provides a list of the possible combinations that can be used with Thresholds. Notice
that the first four are claim level, while the remaining three are line item based. These three calculation
options are used to apply a rate on the claim, but the rate will be held within the limits of the Apply to
Start and Apply to End fields that are set in the Threshold form.

Calc Basis Calc Measure Calc Type

DRG, CPT4, Rev Code, etc. Dollar Rate Per Diem
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Calc Basis Calc Measure Calc Type

DRG, CPT4, Rev Code, etc. Dollar Rate or % Charge Per Claim

Any and All Services Dollar Rate Per Diem

Any and All Services Dollar Rate or % Charge Per Claim

CPT4 or Rev Code Dollar Rate or % Charge Per Date

CPT4 or Rev Code Dollar Rate or % Charge Per Line Item

CPT4 or Rev Code Dollar Rate or % Charge Per Line Item Qty

� Threshold examples
The following examples illustrate two situations for using thresholds.

NOTE: Regarding Lower Bounds – The Total Charges or Total Covered Days needs to fall within the
bounds. On the second tier, you may repeat the Low Bound or you may use the given start for the
next tier. The result will be the same as the Apply Start comes into consideration and will only apply
the rate on the excess.

It is important for the first tier to have bounds that capture the full range from 1 to infinite, as that will
ensure the lower tier is also calculated in these examples.

Charges
A payer might state that inpatient services are paid at 50% of charges but any inpatient claim that has
charges in excess of $100k will pay “Tiered Reimbursement” for which there would be varying
reimbursement rates depending upon the charges. In this example, you need to define a couple of key
terms:

l The Thresh Basis is Total Charges because we are paid a different rate based on the charges on the
claim (after we exceed $100k on a claim reimbursement changes)

l Two Rates need to bemodeled. As an example:
o 50% for the all claims up to $100k
o 75% on all claims exceeding $100k

l The bounds capture the Total Charges from the claim. For the 50%Rate, the Lower Bound would
be $1 and the Upper Bound would be infinite ($99,999,999). The next fields control the application
of the rate. The Apply to Start would be $1 and the Apply to End would be $99,999k because we
want the 50% to apply to all charges up to $100k.

l For the 75%Rate, the Lower Bound could again be $1 or change to $100k and the Upper Bound
would be $99,999,999. Remember, the Total Charges need to fall within the bounds. However, the
Apply to Start would now be $100k and the Apply to End would be $99,999,999 because wewant
the 75% to apply only to the charges over $100k.
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Days
A popular example of Day Thresholds is Maternity Cases. Often Maternity pays a Case Rate for a set
number of days and then adds reimbursement for days in excess.

l The Thresh Basis is Per Diem because we are paid a different rate based on the Covered Days on
the claim

l Two Rates need to bemodeled. As an example:
o The Case Rate for Days 1-3
o The Per Diem Rate for Days greater than 3

l The bounds capture the Total Covered Days from the claim. For the Case Rate, the Lower Bound
would be 1 and the Upper Bound would be infinite (999). The next fields control the application of
the rate. The Apply to Start would be 1 and the Apply to End would be 1, because wewant the
Case Rate to only calculate once. So wewill have it calculate on the first day (eliminate claim
variability).

l For the Per Diem Rate, the Lower Bound could again be 1 or it could be 4 and the Upper Bound
999. Remember, the Total Covered Days need to fall within the bounds, but the Apply columns
control applying the rate. So the Apply to Start would be 4 and the Apply to End would be 999
because wewant the Per Diem Rate to apply only to days exceeding the defined parameters of the
case rate.

Manually add a threshold to a clause or term

Use these instructions to add a simple threshold to a clause or term. For adding more complicated
thresholds, see Import a threshold for a clause or term.

To import a threshold file:

1. Navigate to the desired clause/term.

2. In the Threshold column, click the Edit icon ( ). If you are adding a threshold for the first time,

the icon is grayed out.

3. In the Edit Thresholds dialog, in the Thresholds tab, click Add a New Row.

4. Enter information in the following column fields: Code, Description, Rate, Thresh Basis, Lower
Boundary, and Upper Boundary, and Apply to Start and Apply to End, as desired. For information
on these fields, see Using calculation bases, measures, and types in thresholds and Threshold file
requirements. To locate codes, use the look up option.

5. To add another threshold, repeat steps 3 and 4.

6. (Optional) If you need to add multiple rows that will have the same information for each code, you
can copy the rows instead of adding each manually.

7. Click Save.

Import a threshold for a clause or term

When adding a threshold to a clause or term, you select themethod of payment for the clause or term.
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You can add thresholds to a clause or term manually; however, you can add more complicated
thresholds using the attach thresholds option. With this option, you build your threshold requirements
in Excel and upload them to the system instead of entering them manually one at a time. This is the
preferred method for more complex thresholds. For information on threshold files, see the following
Threshold file requirements.

Before attaching threshold files, review the file requirements:

� Threshold file requirements
Unlike regular rate files, threshold files require a minimum of the following fields:

l Code – Code used for match (DRG, CPT4, etc.)
l Rate – The rate to reimburse if claim/linematches the threshold conditions (Percentage or Dollar

Rate). Percentages must be represented as decimal values. For example, 100%→1. 99%→ .99
l Thresh Basis – The thresh basis controls which piece of information on the claim/line is analyzed

by the calculation engine to determine if there is a match. Enter the corresponding number below
in the Excel file. For example, if calculating Per Diem, enter 1 for each entry in the file.

o Claim Level Based

o (1) Total Days (Per Diem)

o (2) Total Charges (Per Claim)

o Line Item Based

o (3) Line Charges (Per Line Item),
o (4) Line Units (Per Line Item Qty),
o (5) Total Daily Units (Per Date Units),
o (6) Total Daily Charges (Per Date Charges)

l Lower Bound / Upper Bound – The lower bound represents the lowest value for your thresh basis
trap. The upper bound represents the highest value for your thresh basis trap. Anything greater
than or equal to the lower bound, and less than or equal to the upper bound, will be considered a
match.

l Apply to Start / Apply to End – In some cases, you may only want to apply a percentage (%) to a
range of your charges, or only apply a per diem on certain days. If this is the case, you would set
your “apply to start” and “apply to end” to the range of days or charges to which you want to
apply your rate.

A Description is not needed in the file because it will populate from the corresponding library. Codes that
are in the file but do not have a library entry will get a default description of NO DESCRIPTION.

To import threshold files to a clause or term:
1. Navigate to the desired clause/term.

2. In the Threshold column, click the Edit icon ( ). If you are adding a threshold for the first time,
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the icon is grayed out.

3. Click the Files tab.

4. In theUpload tab on the right, drag the threshold file to theUpload files to a selected folder
area or click Select files and select the threshold file.

5. Click Upload. The file name displays under the Thresholds folder on the left.

6. Select the file, and then click the Specify tab on the right. The top part of the tab displays an image
corresponding to the data in the uploaded file.

7. Define the columns of your file (refer to Threshold file requirements if needed):

a. On the lower right of the dialog, in the Excel Column, for each row in the Rates Column,
select from the drop-down the letter that corresponds to the column in the image above.
In the following example, Code corresponds to column A in the threshold file. Do this for
each field in the Rates Column that needs to bemapped.

b. For Excel data has column headers? select the appropriate option.

8. Under themapping table on the right, click Save Specifications.

9. At the top of the dialog, click the Import tab. The file you uploaded displays under Specified
Thresholds Files.

10. On the right side of the dialog, click Attach. When the file is attached, the file’s check box displays
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as checked.

11. To view the imported thresholds, click the Thresholds tab.

12. Close the Edit Thresholds dialog.

Using limits
Axiom Contract Management gives you the ability to model “lesser of” and/or “greater of” language
common among many payers. These are known as limits because they limit reimbursement for a
particular case, and can be added to any clause, term, or provision in a contract. In the contract level
hierarchy, limits sit on top of clauses and terms, which means they belong to the particular clause or
term they reside on. Global limits belong to the provision that they reside on.

� Limit restrictions
In Axiom Contract Management, you do not need to worry that your limit may not be compatible with
the parent clause or term that you are adding it to, because the system handles it automatically. The
type of limit you can set on a particular clause or term depends on its parent type. For example, if you
are creating a limit on a case rate type clause, the type of limits available when you build it are restricted
to case rate calculation bases and types. If you are creating a limit on a line item clause or term, the limit
selections will be for line item calculation bases and types.

� What is a Maximum?
AMaximum sets a limitation on the particular clause or term it sits on, restricting it to a specified amount
that it can receive at most. For example, if you would like to limit reimbursement to the lesser of 100% of
charges on a DRG Case rate clause, you would set a max on that clause paying 100% of Any/All Services.
When the claim is calculated, the calculation will create a record for the DRG Case rate, a record for the
Maximum, and then compare the two and pay whichever is less.

� What is a Minimum?
Aminimum sets a limitation on the particular clause or term it sits on, restricting it to a specified amount
that it must receive at a bareminimum. For example, if you have a percent of charge clause that pays
50% of charges but your contract states that you will receive at least $500 for every claim, then you would
create a minimum on your % of charge clause, setting it to pay $500 of Any/All Services per claim.

� Limit hierarchies
In many cases, you will be creating contracts for which you have terms attached to clauses, and would
like to limit both the clause and its attached terms. Axiom Contract Management allows you to do this by
setting limits on both terms and their corresponding parent clause; however, there is a hierarchy
involved when doing so.
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After all applicable terms are calculated, the clause limit is applied as a final step to determine if the limit
(s) apply or not. Remember, terms report their reimbursement back to their parent clause, so if a limit
exists on the clause, all terms attached to it are subject to that limit.

There are cases in which you will not want to include a particular terms reimbursement when applying
the limit. The system allows for this by enabling you to toggle a term’s Include option. When you set a
limit on a term, a check box becomes enabled on the term, allowing you to include its reimbursement or
to exclude its reimbursement from reporting back to the parent clause’s limit. In Axiom Contract
Management, these are known as “Carve-out” terms. Their reimbursement does not count toward the
parent clause limit and are added to the result after the limit winner is determined. The Include option
can be located on terms for normal limits, and clauses for global limits.

Creating limits

Limits are defined generally as Maximums and Minimums, and they either cap or raise reimbursement.

You can create limits on the following contract levels:

l Provisions
l Clauses
l Terms

NOTE: Limits on provisions are called global limits because they apply to all clauses and terms under
the provision.

To create a limit:
1. Navigate to the desired clause or term.

2. To add a limit to a clause or term, do one of the following:
l Add a line item limit.
l Add a maximum and/or minimum limit.

3. To add a limit to a provision, add a global limit.

After setting a limit, the Edit icon is no longer grayed out.

Create a maximum or minimum limit

Adding a minimum or maximum limit to a clause or term restricts the reimbursement to a specified
amount that it can receive at most or at least.

NOTE: You can create only onemaximum and oneminimum per clause or term.

To create a maximum or minimum:
1. Navigate to the desired clause or term.

2. In the Limits column, click the Limit icon ( ).
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3. On the Limits page, do one of the following:
l To create a maximum, select theMaximum check box.
l To create a minimum, select theMinimum check box.

4. In theDescription field, select a description from the drop-down.

5. In the Calc Basis field, select a calc basis from the drop-down.

6. Select a Calc Type and a Calc Measure.

NOTE: Depending on which calc basis you selected, you may or may not need to, or be able
to, select a calculation type and calculation measure.

7. Click Save.

8. To set rates, do one of the following:
l For a single rate, type the rate into the Rate field.
l When multiple rates are required, a Rates button displays below the grayed-out Rates field.

To add multiple rates, click the Rates button and then add rates manually or import rates.

9. If you are creating both a maximum and a minimum, select theMinimum check box and then
complete the fields as you did for themaximum limit. You will need to save your selections before
you can enter a rate.

10. Click Save.

11. (Optional) If desired, set an exclusion for the limit(s).

Create a global limit

Global limits allow you to set a maximum and a minimum amount for reimbursement on a claim. Global
Limits are applied at the provision level and apply to all clauses and terms under the provision. To apply a
limit to a specific clause or term only, see Creating limits.

To create a global limit:
1. Navigate to the desire clause or term.

2. In theGlobal Limit column, click the In theGlobal Limits column, click the Limit icon ( ).

3. On theGlobal Limits page, add a maximum or a minimum, or both, as desired. The steps for
setting both are identical:

a. Select theGlobal Maximum (or Global Minimum) check box. Below the check box, settings
fields display populated with defaults.

b. In theDescription and the Calc Basis fields, select from the drop-down. You can search the
lists in these drop-downs by clicking the field and then typing the description or calculation
basis to search for. The list filters to the first letter or word you typed.
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c. For Calc Type and Calc Measure fields, either leave the default or change the selection as
needed.

NOTE: In some cases, you will not be able to select an option different from the default
if the field is dependent on another field. For example, the selected Calc Type can limit
the Calc Measure you can select.

NOTE: You cannot set a rate or an exclusion until you save your selections for the other
fields.

4. Click Save.

5. Do one of the following:
l For single rates, in the Rate field, enter a rate.
l When multiple rates are required, a Rates button displays below the grayed-out Rates field.

To add multiple rates, click the Rates button and then add rates manually or import rates.

6. (Optional) Set an exclusion.

7. Click Save.

Create a line-item limit

When a limit is defined on a line-item clause or term, it no longer compares the final reimbursement for
that clause or term to the limit, but instead compares the reimbursement to the limit on a line-by-line
basis. Themost common way to use the line-item limit is by capping fee schedules at the charge amount.
The capping of fee schedules is language common to several managed care contracts, which typically
would state that all fees are paid the lesser of charges or the pre-determined fee scheduled amount.

Administrator's Guide Axiom Contract Management │ 93



To create a line item limit for a clause or term:
1. Create the clause or term, or navigate to an existing clause or term that has a line item calculation

basis.

2. In the Limits column, click the Limit icon ( ).

3. On the Limits page, select either theMaximum orMinimum check box.

4. From theDescription drop-down, select a description.

5. From the Calc Basis drop-down, select Line Item Code.

6. From the Calc Type drop-down, select Dollar Rate.

7. From the Calc Measure drop-down, select Per Line Item.

8. Click Save.

9. Below the Rates field, click the Rates button and attach your fee schedule to the clause/term. See
Import rates for a clause or term for detailed instructions on attaching fee schedules.

Add a unit max limit to an MPR calculation

Use these instructions to add a Unit Max limit on a contract clause or term that uses the Line Item MPR
calculation basis. Setting a unit max limit puts a cap on howmany units are paid. The unit max acts as a
counter; when the limit is reached, additional claims for that item are paid at $0.

NOTE: The Unit Max limit used on an MPR calculation applies to professional claims only.

To create a line item MPR clause or term:
1. Navigate to the Clauses or Terms page for the desired provision.

2. Click +Add a New Clause (or +Add a New Term).

3. In the Add a New Clause (or Term) dialog, from the description field, select a description.

4. From the Calc Basis drop-down, select Line Item Code MPR.

5. From the Calc Type drop-down, select either Dollar Rate or% Charges, whichever applies.

The Calc Measure drop-down is set automatically to Per Line Item, which is required for this
calculation basis.

6. For Terminal? select either Yes orNo.

7. Click Save.

8. Import rates and translation tables.

To add a unit max limit to an MPR calc method on a clause or term:
1. Navigate to the desired clause or term that has theMPR calculation method.

2. In the Limits column of the new clause/term row, click the Limit icon ( ).
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3. On the Limits page, select theMaximum check box.

4. From theDescription drop-down, select a description.

5. From the Calc Basis drop-down, select Unit Max.

Notice that you cannot select a Calc Type.

6. From the Calc Measure drop-down, select whether themax should be applied per claim, per date,
or per line item.

7. Click Save.

8. In the Rates field, enter the unit limit. For example, if the unit is the number of therapy sessions,
and the contract stops paying after the 6th visit, enter 6.

9. Click Save.

The voucher report for claims that are run against this limit will display the limits and a payment of
0 once the rate cap is met.
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Copy, move, delete, or download attached files
Use these instructions to handle attached files, such as rate files, residing in system folders. If there are
schedules or rate files you can use from other contract version(s), in the Files tab of Edit dialogs for
attached files, you can either move a file or make a copy from another folder location by dragging and
dropping. You can also download a file, make changes to it and then upload it.

To move, copy, download, or delete a file:
1. Navigate to the desired contract level and then open the Edit dialog for the attachment. For

example, if working with a rates file, then in the Rates column, click the Edit icon ( ).

2. In the Edit dialog, click the Files tab.

The left side of the tab displays the Rates Library and the folder system leading to the attached file.

NOTE: To see the folder structure for all simulations, above the folder structure, select the
Show all folders option.

3. Drill down through the clause/term calculation basis to the desired document, select the file, and
then do any of the following:
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IMPORTANT: Although information imported from files is retained when you delete or move a
specified file, if you import another file and attach it to the clause or term, the previous
information is replaced with the new information.

� Copy the file to another folder
a. Below the folder tree, in theDrag/Drop section, select the Copy check box.

b. Drag the file to the destination folder. The original file stays in the source folder.

� Move the file to another folder
a. Below the folder tree, in theDrag/Drop section, select theMove check box.

b. Drag the file to the destination folder.

� Delete the file

NOTE: If the file is in use (the file icon to the left of the name is solid), you can delete it without
removing the information from the clause or term as long as the imported file was the last one
attached. You can also reattach a file before deleting it from the server.

a. Select the file, and then click theDelete button below the folder tree.

b. Click Delete in the confirmation dialog.

� Download the file
a. Select the file.

b. Click theDownload button below the folder tree. he downloaded file displays at the
bottom of the page, as in the following example:

From here, you can open the file, make changes, move the file elsewhere on your
computer, or upload the file to the Contract Management system.

4. Close the Edit dialog.
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Attaching supporting documents to a contract
NOTE: This topic applies to supporting documents attached to versions. Other file types such as rate
files, fee schedules, translation tables, thresholds, and adjustments are added to contracts at the
clause or term level. For information on managing these files, see Using Rates.

When modeling contracts, you may need to attach documents to support the contract. You attach these
kinds of files to contracts at the version level. You can attach files such as images, PDFs, Excel
worksheets, or any other document supporting the contract. Users can download, open and view the
documents as long as they have access rights to do so. Keep in mind that to view attached files, users
must also have an application installed that can read the file type. Only system administrators can delete
documents from contract versions.

Versions with attached files display a circle with check mark icon ( ) in their Attached Docs column.

Copy an attached document to another version
Use these instructions to copy a file attached to one version of a contract to another version of the same
or different contract.

You can download, open and view the documents as long as you have access rights to do so.

NOTE: To view attached files, you must have an application that can read the file type installed on
your computer. Keep this in mind when attaching files.

To copy an attached file from one version to another:
1. Navigate to the contract version to add a file to.

2. At the end of the version row, click the Edit icon:

3. In the Edit Version dialog, click theDocuments tab.

4. In the lower half of the tab, click the Copy a document tab.

5. In the list of contracts, expand the desired contract name and version that contains the file to
copy.

6. Do one of the following:
l To copy all documents attached to the source version, click the up arrow icon ( ) at the

end of the version row.
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l To copy selected documents attached to the version, click the up arrow icon(s) for the
desired document(s).

7. Click Save. When you open the Edit Version dialog again, the copied documents are listed in the
Attached Docs section.

View a file attached to a version
When calculations are off, or there is a discrepancy in the contract data, it may be helpful to view the
actual contract to compare it against themodeled one. If the actual contract is attached to themodeled
contract as a file or files, you can view it as long as you have permissions to view attached files.

NOTE: If you do not have the application required for viewing the document installed on your
computer, you will not be able to open and view the file.

To view an attached contract file:
1. Navigate to the contract version with the attached document.

2. At the end of the version row, click the Edit icon ( )

3. In the Edit Version dialog, click theDocuments tab.

4. In the Attached documents section, locate the document to view and then click the download
icon ( ) at the end of the row. A copy of the document downloads to the bottom of your screen.

5. Click the document file to open and view the document.
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Copying contracts
After a set of contracts is built into Axiom Contract Management, you can use the contract parts as the
basis for new contracts. You have a number of options when copying contracts:

l Copy a version to the same or different contract
l Copy a version to a different contract (using the import version feature)
l Copy a version from a file (using the import file feature)
l Copy a provision to the same version
l Copy a provision to a different version in the same or different contract
l Copy a clause or a term

Copy a version
Use these instructions to copy a version to the same contract. To copy a version to a different contract,
use the Import Version feature.

To copy a version:
1. Navigate to the version to be copied.

2. At the end of the version row, hover your cursor and click the Clone icon ( ).

3. In the Clone Version dialog, on the Settings tab, note that the Start Date and the Expiration Date
have been set one year ahead of the Start and Expiration dates of themost recent previous
version in the version list (not necessarily the one you copied). You can change these dates from
the Edit Version dialog if needed; however, if the changed dates conflict with any provisions that
were copied over with the version, a conflict message displays in the dialog, as shown in the
following example:
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4. By default, any provisions, insurance plan codes, attributes, and attached documents are
included in the copy. However, if you do not want to copy everything, clear the check boxes for
the items that you do not want included in the copy.

NOTE: You cannot make changes to the other tabs in the Clone Version dialog. Save the
version and then make changes in the Edit Version dialog.

5. Click Save.

6. (Optional) Edit the version.

Export a version
Export a version when you want to create an importable file of the version or if you want to create a
backup.

IMPORTANT: Export/Import Provisions is not a preferred tool to copy contracts into Live. It should
be done as a time-saving safety net in case a contract is irreversibly altered incorrectly.

We recommend that you maintain your own contract backups in case of an irreversible error. You can
create backups using the Export Version feature.

To export a version:
1. On the Contracts page, navigate to the desired contract version.
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2. At the end of the version row, click the Export icon ( ).

3. In the Export Version dialog, type a name for the exported version file or leave the default.

4. Click Export.

The exported version file will be available in the Import Version dialog when you select to import a
version from a file.

Copy a provision
If an existing contract is similar to the one you are working on and needs only slight modifications, you
can copy that provision instead of re-building it from scratch, then edit the copy. Use the following
instructions to copy a provision within a version. To copy a provision from a different version, use the
Import Provision feature.

To copy a provision within the same version:
1. Navigate to the provision to be copied.

2. At the end of the provision row, click the Clone icon ( ).

3. In the Clone Provision dialog, in the Settings tab, type in dates or click the calendar icons ( ) and

select a Start Date and Expiration Date for the provision.

NOTE: The system will not allow you to select dates that are outside of the associated
version’s active period. You also cannot create a provision with dates that overlap another
provision that has the same bill type.
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4. By default, any attributes are included in the copy. However, if you do not want to copy them,
clear the Include Attributes check box before saving. You can add other attributes after you save
the new provision.

NOTE: You cannot add or remove bill types from the Clone Provision dialog. You must save
the copy and then make changes through the Edit Provision dialog.

5. Click Save.

6. (Optional) Edit the provision as desired.

Import a provision
Use these instructions to copy a provision from one contract to another. The Import Provisions feature
allows you to bring in provisions from a contract in any simulation.

To import a provision:
1. Navigate to the desired contract version.

2. In the version row after the version number, click Go to Provisions.

3. On the Provisions page, note the date range of the version displayed at the top of the page. The
provision you select to copy must fall within that date range. If it does not, you can change the
date range on the copy before importing it.
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4. On the Provisions page above the table of provisions, place your cursor over the arrow, and then
click Import from another contract.

5. In the Import a New Provision dialog, from the Simulation drop-down, select the simulation
containing the provision you want to copy.

6. In the Select a provision to import list of contracts, expand the desired contract and version to
locate the provision to import.

7. If any of the Start or Expiration dates are red for the provision you want to import, click in the
Start Date and Expiration Date fields and select dates that match the Start and Expiration dates of
the version to which you are importing the provision. When updated successfully, the dates turn
black and the provision check boxes are enabled.

8. Select the check box for the desired provision (you can import more than one).

9. (Optional) If applicable, select to import associated attributes or other attachments by selecting
the corresponding check box below the list of contracts.

10. Click Import.
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Managing simulations
The ability to run a nearly endless number of simulations is one way that Axiom Contract Management
sets itself apart from older editions. Simulations are an essential tool during contract negotiations,
allowing you to model a number of proposed contracts and run reports for comparison to determine
which proposal is most profitable.

Create a simulation
Creating simulations that model the identical contract structure allows you to get a more accurate view
of how facility reimbursement is changing, and which services are affected. After creating a simulation
you can add contracts to it.

To create a simulation:
1. At the top of the Contracts page, to the left of the simulation drop-down, click the Edit icon:

2. In the Edit Simulations dialog, above the table of simulations, click Add a new Simulation. A new
simulation row is added to the table, as shown in the following example.

6
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3. In the new row, type a name for the simulation and then click Save. The newly created
environment can now hold contracts.

4. Add a contract to the simulation.

Edit or delete a simulation
Use these instructions to change a simulation name or to delete a simulation.

To change a simulation name or delete a simulation:
1. At the top of the Contracts page, click the Edit Simulations link.

2. In the Edit Simulation dialog, for the desired simulation, click and then edit the name.

3. To delete a simulation, at the end of the simulation row, click the Delete icon ( ).

4. Click Save.

5. Close the Edit Simulation dialog.

Setting up reporting across simulations
Axiom Contract Management administrators can assign simulations to the Expected Payment drill-down
reporting field for side-by-side reporting and analysis. Administrators can map up to four simulations for
a total of fivemapped simulations. The first mapped simulation is to the Live environment, which you
cannot change.

� How the mapping works
The Estimated Payment fields in drill-down reports are used in this case to compare estimated payments
between different simulation environments. These fields are defined with the following field names:
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l TotalExpectedPayment1where 1= Live simulation; so TotalExpectedPayment1 equates to
Estimated Payments from Live in drill-down reports

l TotalExpectedPayment2where 2 = a simulation of your choice
l TotalExpectedPayment3where 3 = a simulation of your choice
l TotalExpectedPayment4where 4 = a simulation of your choice
l TotalExpectedPayment5where 5 = a simulation of your choice

When users build drill-down reports, they need to include the TotalExpectedPayment variable for the
desired simulation in a calculated field they add to the report.

In the following example, a contract is compared between two simulations. The calculated fields Exp
Pay1, Exp Pay1%, and Exp Profit1 aremapped to the Live environment by using the variable Total
Expected Payment1 in the equation for each calculated field:

l Exp Pay1 = Sum (Total Expected Payment1)
l Exp Pay1% = Sum (Total Expected Payment1)/Sum (Total Charges)*100
l Exp Profit1 = Sum (Total Expected Payment1)-Sum (Total Cost)

The calculated field Exp Pay2% is mapped to the EPAY2 simulation by using the variable
TotalExpectedPayment2 in the equation: Exp Pay2% = Sum (Total Expected Payment2)/Sum (Total
Charges)*100

The generated example report looks like the following:

Administrator's Guide Axiom Contract Management │ 107



IMPORTANT: Since only administrators can see which simulations aremapped to each mapping
assignment field, as an administrator, you will need to create the custom calculated fields needed
and name them appropriately. For example, a calculated field representing Sum(Total Expected
Payment 1) for a simulation named Aetna KMC could be named AetnaKMC Exp Payment. For
information about creating calculated fields, see “Add calculated fields to a report” in the online help.

� Map simulations to drill-down reporting Expected Payment fields
To map simulations to expected payments variables:

1. In themain menu header, click Admin > Simulation Mapping.

2. For Mapping Assignment 2, click the drop-down arrow and pick a simulation to assign to the
Estimated Payment drill-down reporting field.

NOTE: Mapping Assignment 1 is set to the Live simulation environment. This cannot be
changed.
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3. Repeat for the other mapping assignments as desired.

4. Click Save.

When you make a change to this assignment and click Save, the field is cleared to ensure that all past
calculation results from previously used simulations are not still stored and used in the report.

NOTE: Results from a newly assigned simulation become available only after a user calculates
contracts within the selected simulation. Past calculation results are not retained for a simulation
when it is assigned to a different mapping field.
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Working with claims
The View a Claim function in Axiom Contract Management allows you to access or view all information
related to claims. Themultiple forms of information are compiled from data contained in the Claims,
Payments, and adjustments imports. Other important data fields are calculated by the system, or
imported from other Syntellis systems.

You have the following options for selecting and viewing claims:

l Patient Account Number – Account number or billing identification number imported from the
Claim

l Patient Name – Patient Last Name or any part of Patient Last Name imported from the Claim
l Claim\Number UCRN – Unique record number or Claim Sequence number assigned by Patient

Accounting System

� Live Claims Only option
The Axiom Contract Management system defaults to Show Live Claims Only. To have the system return
results for all instances of the claims, clear the Live Claims check box beforemaking a View a Claim
Selection.

� Access View a Claim
To access View a Claim:
In themain menu header, click Claims > View a Claim.

The View Claims page opens.

7
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Claims page example

View a claim by selected criteria
To select claims by Patient Account Number:

1. From the View Claim Bymenu, select Patient Account Number.

2. In the Enter a Patient Account # field, enter the account number and then click View Claim(s).

To select claims by Patient Name:
1. From the View Claim Bymenu, select Patient Name.

2. In the Enter Patient Name field, type any part of a patient last name, and click View Claims(s). If
this does not work, type in the patient’s first and last names.
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NOTE: If the criteria selected matches multiple claims, all of those claims will appear in the
Account Selection List.

To select claims by Claim/Number UCRN:
1. From the View Claim Bymenu, select Claim #/UCRN.

2. In the Enter a Claim #/UCRN field, enter the number and then click View Claim(s).

� Account Selection List details
If you click on the gray account field Name, the system sorts the list by that column.

The account selection list contains the following claim fields:

l Acct# – Lists the account number imported from the claims.

NOTE: This field is also a link that will bring you into the Claim Details section of View a Claim.

l Claim Type – Identifies the type of claim and its status in Axiom Contract Management
l Organization – Identifies the organization imported from the claim
l Patient Name – First and Last name imported from the claim
l MRN –Medical Record Number imported from the claim
l Admit Date – Admission data imported from the claim
l Discharge Date – Discharge data imported form the claim
l Sub Date – Submission date imported from the claim

l Total Charges – Total Charge amount imported from 0001 line on the claim form minus non-
covered charges
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View claim details
The claim details section of Axiom Contract Management provides an easy-to-use interface that allows
you to view all information associated with a claim. Use the tab-based web pages to navigate from
summary-level information to detailed line item information. To view information on a tab, click the tab
name.

On themenu on the left side of the Claim Detail page are additional options:

l View Voucher – Click this button to open a new browser tab containing the Claim Voucher
Report.

The Claim Voucher Report provides an explanation of exactly how the system arrived at the
expected payment, and howmuch the payer has paid. This information is ideal for follow-up with
the payers to ensure proper payments are being received.

l Go to Contract – Click this button to open the contract in a new browser tab. Additionally, the
specific contract clause will be highlighted, as shown in the following example.
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l Grouper Edits – Click this button to detail all OCE/NCCI and eAPG edits. This is important when
determining why a Medicare claim has an expected payment = $0. In Axiom Contract
Management, if there is an edit on a line item (code, modifier, etc.), the system automatically pays
the claim at $0. This helps you easily identify claims that can potentially be fixed and re-billed for a
higher total redemption from Medicare. Following is an example of Grouper Edits for APC ICD9
Code edits.

l Recalculate – Click this button to recalculate the current claim. For more information, see
Recalculate a claim from Claim Detail.

� Claim Detail tabs

� Summary tab
The Summary tab displays information identifying the type of account, the contract used for calculation,
and important demographic information. The Summary tab also contains all the information necessary
to identify whether a claim is paid correctly.

l Expected Payment – Calculated expected payment using contract terms
l Expected Contractual – Total Covered Charges minus Expected Payment
l Actual Payments – Total of all Payments imported by Account # from payment import file
l Actual Contractual – Total of insurance contractual imported by Account # from Contractual File
l Payment Variance – The difference between Expected Payment and Actual Payments
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l Contractual Variance – The difference between Expected Contractual and Actual Contractual
l Total Cost – Sum of Fixed, Variable, and Indirect Cost
l Fixed Cost – Imported from Cost Accounting System – represents fixed cost (materials and labor)
l Variable Cost – Imported from Cost Accounting System – represents variable cost (overtime)
l Indirect Cost – Imported form Cost Accounting System – represent cost not specifically assigned

to dept.
l Actual Profit – Total Covered Charges minus Actual Payments
l Expected Profit – Total Charges minus Expected Payment

� Codes tab
The Codes tab contains all code-related information imported from the claim form. This information
includes:

l ICD9 Codes – Diagnosis and Procedure Codes
l Condition Codes
l Occurrence Codes
l Occurrence Span
l Value Codes
l User Defined Codes

You can navigate through the various code types by clicking the name of that code type. Code type
selection options are shown outlined in red in the following example.

� Demographics tab
Use the Demographics tab to view demographic information imported from the claim.
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� Insurance tab
Use the Insurance tab to view information imported from the claim associated with Primary, Secondary,
and Tertiary payer information.

� Line Items tab
Line Items tab is very important for claim review. Access the tab by clicking the Line Items tab. This tab
displays imported Revenue Code detail for all claims, and Medicare APC information for Medicare OP
claims. The following examples represent a view of a Non-Medicare Claim and aMedicare Claim,
respectively.
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Non-Medicare claim

Medicare claim

Medicare Claims contain two non-Imported Fields with values assigned by the 3M APC GPS software
during import:

l APC – Ambulatory Payment Classification

l Status Indicator (SI) – Identifies type of APC

To see the description of a code listed in the Line Items tab, move your cursor over that tab, as shown in
the following example:
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� Physicians tab
The Physician tab displays physician information imported from the claim.

� Postings tab
The Postings tab details each payment posted to a claim. The system default view is Payments; however,
you can change the view to show the different types of postings individually or together by clicking the
Contractuals or All radio buttons, respectively.

� Tracking tab
The Tracking tab allows you to mark an individual claim for follow-up. This includes identifying:

l The claim’s status
l A generalized assignment category
l The user the claim is assigned to
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l Ten user-defined fields
l Any additional notes

It also allows you to view the claim’s Tracking History to see how it has been managed, and follow it
through the recovery process. A summary of this information is provided on the Summary tab for quick
reference when you open an account.

View Grouper Edits for a claim
When claims are grouped and priced, they may create edits that affect reimbursement. You can view
these edits on a claim and switch to any relevant simulation these claims apply to from the Grouper Edits
dialog. A Simulation menu at the top of the dialog allows you to select different simulations to see any
grouper edits that simulation produces for the given contract (the contract needs to bemodeled in the
simulations you select).

To view grouper edits on a claim:
1. From the Claims menu, select View a Claim.

2. Filter for and select the desired claim.

3. In the sidemenu of the Claim Detail page, click Grouper Edits.

4. At the top left of theGrouper Edits dialog, from the Simulation drop-down, select the desired
simulation.

The report lists any grouper edits that resulted from grouping and pricing the claim in the selected
simulation.
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For more information, see the following:

l “View claim details” in the online help
l “Group and priceMedicare/Medicaid claims” in the online help

Using claim tracking
Use Claim Tracking to organize institutional claims that need attention and easily locate them at another
time.

Assign a claim
Assigning a claim is the first step in using the Claim Tracking feature.

To assign a claim:
1. In themain menu header, click Claims > View a Claim.

2. In the View Claim By section on the left, select the criteria for the claims to view, then click View
Claims.

3. In the Acct # column, click the number of the claim to assign.

4. On the claim detail page, click the Tracking tab.

5. Select the following claim details:
l Claim Status – Select Open, Closed, or other user-defined status (Needs Review, Insurance

Pending, etc.).
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l Assignment – Select the general reason for assignment. This is also a user-defined field.

l Assigned To – Select the user assigned to this claim. This is a list of all system users, and is
generated by Syntellis, and cannot be changed.

l User Defined (1 – 10) – Select up to five user-defined fields with numeric formats, and five
with character formats. Administrators can edit them as needed.

l Notes – (Optional) Add any additional information in this text box. For example, provide
details about the generalized assignment reason to offer more specifics to this particular
claim.

6. Click Save. The claim displays in the Tracking History section.

Claim details example

NOTE: System administrators can build new Claim Status options, Assignment options, and User
Defined options into the system from Claim Tracking, as described in Edit user-defined claim tracking
quick filters.

As you follow the claim through the recovery process, you can make additional notes to any of the
critical information on the page. Themost recently saved information displays at the top of the Tracking
History section.

Track assigned claims
Use these instructions for locating claims using the Quick Filters.

Administrator's Guide Axiom Contract Management │ 121



View Tracking tab example

To view/track assigned claims:
1. In themain menu header, click Claims > Track/Assign Claims. The claim tracking page opens.

2. In the View Tracking tab, leave the default filter setting at Use Quick Filters.

3. In the Select quick filters section, select the following claim details:
l Assignment – Select the general reason for assignment, or select Any to return all claims

that match any assignment.
l Assigned To – Select the user assigned to this claim, or select Any to return claims that

match any user. This is a list of all system users, and is generated by Syntellis, and cannot
be changed.

l Status – Select Open, Closed, or other user-defined status (Needs Review, Insurance
Pending, etc.).

l Opened By – Select the user, or select Any. This list cannot be changed.
l Closed By – Select the name of the user or select Any. This list cannot be changed.

NOTE: Only users who set a claim tracking status to “closed” on a claim appear in this
list.

l Denial Category – Select a category or select Any to return claims that match any of the
categories.

l Denial Reason Code – Select a code or select Any to return claims that match any of the
denial reason codes.
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l Service Location – Select a location or select Any to return claims that match any of the
locations.

l Priority – Select the priority or select Any to return claims that match any priority.
l Closed Reason Code – Select a code or select Any to return claims that match any of the

codes.

4. Click View Claim(s). This list of claims matching the set criteria displays below the filter options.

5. To export the list of claims, click Export List. The list is exported to an Excel file that displays in the
lower left corner of the page. Click the file to open it.

6. To view a claim in the list, in the Acct # column, click the linked account number.

Edit user-defined claim tracking quick filters
Some of the claim criteria used in claim tracking Quick Filters can be user-defined. Quick filters allow you
to locate only the claims that match the selected Quick Filter criteria.

To edit user-defined claims criteria:
1. In themain menu header, click Claims > Track/Assign Claims. The claim tracking page opens.

2. In the View Tracking tab, ensure that Use Quick Filters is selected.

3. In the Select quick filters list, click the desired user-defined quick filter. The edit dialog for that
variable opens. In the following example, the Status variable options are being edited.
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4. Do any of the following as desired:
l To add a new option, click Add New. A new line is added to the table. Type the option in

the row.
l To edit an option, click in the row and make the desired change.
l To delete an option, click the blue cell to the left of the name and then click Delete.

5. Click Save.

6. Click Close.

Use filters in claim tracking
You can also use advanced filters in Claim Tracking.

To use an existing filter:
1. On the Claim Tracking page, click Use Existing Filter.

2. From the Select existing filter drop-down, select a filter.

You can build filters here as shown in the following example. Use the same steps as for building an
Advanced Filter in Reports.
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To build a new filter:
1. On the Claim Tracking page, click Use Existing Filter.

2. Follow the instructions in Build an advanced filter.

Assign claims from claim tracking
Assign claims from the Claim Tracking page by performing a mass modification.

To assign claims from Claim Tracking:
1. In themain menu header, click Claims > Track/Assign Claims. The Claim Tracking page opens.

2. Click theModify Tracking tab. This tab provides threemethods for selecting claims: Current View,
Quick Filters, or Existing Filters.

3. Select one of the following options and follow the provided instructions.

� Current View
Use this method to modify the tracking details of claims currently in the tracking page:

a. Click Use Current View.

b. In the Select modifications column, edit the tracking detail options.

c. ClickModify Claims. Also, if claims are in the Current View, you can sort the claims and
export them to MS Excel. You can sort on the current page, or, if there are numerous pages
of claims, you can sort the entire set. This option is boxed in green in the following example.
To the right of the Sort feature is another set of options. Here you select whether to export
the current pages or all pages in the set. Then, to export to Excel, click the Export List
button next to the View Claim(s) button, as shown outlined in red in the following Quick
Filters example.
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� Quick Filters
To use this method to mass modify claims:

a. Click Use Quick Filters.

b. In the Select quick filters column, specify the tracking details of the claims to modify.

c. In the Select modifications column, specify the new tracking details to apply.

d. Do one of the following:
l To modify the claims immediately, clickModify Claim(s).
l To review the claims found, click View Claims; then, if the returned dataset is

correct, clickModify Claims.

� Existing Filters
The Existing Filters list contains filters built in Claim Tracking, and advanced filters built in Reports.
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IMPORTANT: Use caution when using Advanced Filters from Reports to select accounts in
Claim Tracking. Basic report parameters require you to specify a contract to run your report
on as well as a discharge date range. The advanced filter does not necessarily specify a payer
or date range; therefore, your returned results may be for all payers for the entire database.
Modify by filters carefully and be sure to view your results before applying changes.

To use this method to assign claims based on existing filters:

a. In the Select existing filter drop-down, select a filter. Alternatively, you can click the Build
Filter button and build a filter from scratch, as explained in Build an advanced filter.

b. In the Select modifications column, specify tracking details to apply by editing the
modifications.

c. ClickModify Claim(s). This can also be done in two steps by first clicking View Claim(s).

� Customizing filters
As mentioned in Assign a claim, Axiom Contract Management includes ten User Defined fields, five of
which are formatted numerically and five of which are formatted as characters. You can also hide
columns to prevent them from entering claim tracking reports. For example, if you want to eliminate the
name field from claim tracking to comply with HIPAA regulations, contact a Syntellis representative.

Simulate adjustments to claim charges
Use the Charge Adjustments feature to preview adjustments to claims charges in simulations to
understand the impact they will have on your net reimbursement and future contract performance.

NOTE: This feature is available to administrative users only.

To preview claim charge adjustments:
1. If one does not already exist, create a simulation and add contracts for which you want to preview
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price changes.

2. From the Claims menu, select Charge Adjustments.

3. From the Simulation drop-down, select the simulation that has the contracts against which you
are running claim adjustments.

NOTE: This feature cannot be used in the Live environment.

4. In the Adjust By section, select the desired type of adjustment:
l No Adjustment – Select and then click Clear to clear the current selected adjustment type

and its calculations.
l Overall Percentage – Adjust the charge by a specified percentage.
l Revenue Code – Adjust the charge by programming different revenue codes if they are

different rates, for example.
l Line Item Code – Adjust the charge by specific line items on claims.

5. Do one of the following depending on your selection in the previous step:
l If you selected Overall Percentage, then, in the Adjustment field, enter a percentage

written as a decimal value (e.g., 0.07), and then click Save. Skip to step 7.
l If you selected Revenue Code or Line Item Code, proceed to step 5.

6. To adjust by Revenue Code or Line Item Code, you can input the codes manually or you can
upload a file with the code adjustments. Do one of the following:

l To enter the code adjustments manually:

a. Click +Add new record.
b. In the Code column, type the code, then press the Tab key.
c. In theDescription column, type a description and then press Tab.
d. In the Adjustment column, click the up or down arrow to reach the desired

adjustment number.
e. Click Save changes.
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l To upload a file of code adjustments:
a. Click Select Files.
b. Navigate to and select the file containing the codes and their adjustments.

IMPORTANT: The file should be an Excel file and must have three columns in the
following order: the first column must contain the codes, the second for the
descriptions but can be left blank, and the third should contain the adjustments.
If the Description column is left blank, the system will populate it from the
appropriate library.

The file’s contents display on the page:
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c. (Optional) If desired, you can edit the file contents from this page:
o Edit any entry by clicking it and making changes.

o Delete an entry by clicking the delete icon ( ) at the right end of the row and
then confirming the deletion.

o To add a new code line item, click Add new record and input values.
o To cancel an edit, click Cancel changes (you cannot cancel changes after

saving them).
o Click Save changes to save your edits.

7. Do one of the following:
a. To view how the adjustments affect your reimbursements, calculate the claims and then

view the Voucher details; or from the Reports menu, run any of the standard reports for
the adjusted claims.

b. To preview a new adjustment, select theNo Adjustment option, click Clear, and then
repeat the steps starting with step 4.

NOTE: You cannot select a different adjustment option without first clearing the
existing one. Clearing removes adjustments from all claims in the selected simulation.

The adjustment about to be cleared is listed before clearing. After clearing, Clear Adjustments reads “None.”
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Grouping and pricing APC and eAPG claims
Many contracts include clauses or terms that include APC or eAPG reimbursement methods. Before
these contracts can be calculated, the claim line items need to be grouped and priced into APCs or
eAPGs.

Grouping and pricing can be a slow process when there are hundreds of thousands of claims, which is
why claims processing is usually done during the nightly import. However, you may need to group and
price claims on demand.

The Group and Price Claims page in the Claims section of Axiom Contract Management enables you to
set up, save, and execute claim grouping and pricing tasks. Previously, all grouping and pricing took place
either by a member of Client Success or during the nightly import process on claims coming into the
system. Now you can run this process anytime on selected claims. For information, see Group and price
APC and eAPG claims.

Additionally, you can also use the Shift Date By feature to view a forecast of how new schedules will affect
claims for the coming year.

Group and price APC and eAPG claims
For contracts with clauses or terms that include APC or eAPG reimbursements, you can group and price
claim line items into APCs or eAPGs. You can also run a projection of what future claims will look like by
shifting dates on claims forward in time to understand the impact of new CMS grouping and pricing logic.
For information, see Shift claim dates for grouping and pricing forecasts.

NOTE: Your system must have licenses for APCs and/or eAPGs.

To group and price claims:
1. From the Claims menu, select Group and Price.

2. From theGrouping/Pricing Typemenu, select the desired option:
l APC
l eAPG

NOTE: Only options for which you are licensed display.

3. In Select claims by, select the desired option:

� Patient Account Number
a. In the Patient Account # field, enter the patient account number.

b. From the Claim Status drop-down, select the status of claims to include.
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c. From the Simulation drop-down, select the simulation the claims are in.

� Claim Number/UCRN
a. In the Claim #/UCRN field, enter the claim number or UCRN.

b. In the Claim Status field, select the status of claims to include.

c. From the Simulation menu, select the target simulation for the claims.

� Date Range
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

d. From the Claim Status drop-down, select the status of claims to include.

e. From the Simulation drop-down, select the target simulation for the claims.

� Contract
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

NOTE: You do not have to select Start and End dates if you want to work with the entire
time frame selected by the provision/version.

d. From the Claim Status drop-down, select the status of claims to include.

e. In the Contracts section, from the Current View drop-down, select the target simulation.

f. In the Contracts section, select the contracts to include. You can select an entire contract,
only certain versions of a contract, or specific provisions of a contract.

� Insurance Plan Code
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

d. From the Claim Status drop-down, select the status of claims to include.
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e. In the Ins Plan Code table, from the Current View drop-down, select the target simulation.

f. In the Ins. Plan Code table, select the insurance plan codes to include. You can also select
an entire payer organization if desired.

4. Do one of the following:

l To perform the grouping and pricing now, click theGroup and Price button.
l To process the grouping and pricing later, save the selected claims as a grouping and pricing

task:

a. In the upper right of the page, type a name in the field provided.

b. Click Create a Saved Task

A confirmation message displays that the grouping/pricing task has been queued to run or saved,
depending on your selection.

NOTE: If you selected to save the claims as a group and price task, your task is listed in the
Saved Tasks tab, where you can run it at any time.

Shift claim dates for grouping and pricing forecasts
Users who group and price claims for APG and eAPG contracts can shift dates on claims forward in time
to accurately understand the impact of new CMS grouping and pricing logic for the upcoming year.

IMPORTANT: The shift claim dates feature works only in non-Live simulations.

When the new CMS grouping methods and schedules are released, you can get a forecast of how they
will affect your APC and eAPG claims reimbursements by running some of your historical claims through
the grouping and pricing process using the new rules. Normally, grouping logic prevents you from using
future logic against historical claims because they are service-date specific. However, if you shift your
historical claim dates into the next year, you can align your service dates with the 3M logic.

NOTE: You can also shift the dates backward in time by using a negative number of units. You might
do this if you want to knowwhat this year’s claims reimbursements would have paid last year.

The Group and Price Claims page includes a Shift Date By section that remains inactive until you select a
non-Live simulation in which to group and price your claims. You can use the date shift feature for any
claims selection method (Patient Account Number, Claim Number/UCRN, Date Range, etc.) as long as
you select a non-live simulation.
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To date shift a set of claims for grouping and pricing:
1. In themain menu header, click Claims >Group and Price.

2. On theGroup and Price Claims page, from theGrouping/Pricing Type drop-down, select the
type.

3. In the Select claims by section, select an option, For details, see Group and price APC and eAPG
claims.

4. From the Simulation drop-down, select the desired simulation.

IMPORTANT: The simulation must not be Live.

5. In the first Shift Date By field, click the up or down arrows to select the number of units to shift
the date by.

6. In the second Shift Date By field, click the drop-down and select the unit to shift the date by
(Days, Months, Years).

7. Click Group and Price.

8. After grouping and pricing, view the claim voucher report to see the results.

In the following example, the top of the voucher report shows that the service took place in 2013,
but on the bottom, you see that for calculating the expected payment, it used a future Grouper
Schedule, and therefore, a different Grouper Logic.
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Compare line-level APC calculation detail results
When running drill-down reports on claims and line items, you can include line-level calculation detail
results created from grouping and pricing APCs from any simulation configured for drill-down reporting.
You can do a side-by-side simulation comparison down to the line-level of detail to compare the impact
of APC schedule changes on a set of claims.

NOTE: Your Axiom Contract Management administrator sets up simulations for drill-down reporting.

Claims and Line-level APC results for up to four simulations at a time
In addition to the Live simulation, up to four simulations can be set up to handle reporting of APC detail
at the claim level. Previous to the 2019.3 release, we only stored grouped and priced APC results from the
Live simulation. Now, we have extended grouping and pricing to all other simulations. The fields that are
populated on the Claims and Line items tabs are available for the other four simulations selected for drill-
down reporting. This means there are four fields for each claim and line level field currently populated
during the group and price process (for example, fields such as PPSPayment, CoPay, Outlier, etc.).

Line Item tab Groupings:

l APC2
l APC3
l APC4
l APC5

Line Item tab Measures:
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l Expected Payment 2 - 5
l OPPS EPay CMS 2 - 5
l OPPS EPay Copay 2 - 5
l OPPS EPay Outlier 2 - 5

Claims tab Measures:

l Total OPPS EPay 2 - 5
l Total OPPS EPay CMS 2 - 5
l Total OPPS EPay Copay 2 - 5
l Total OPPS EPay Outlier 2 - 5

To use these new fields in a drill-down report:
1. Run an APC group and price against claims in a simulation mapped to drill-down reporting:

a. Ensure your simulation environment contains the APC contract(s) with the appropriate
Schedule(s).

b. Ensure your simulation environment is mapped to drill-down reporting. You may need to
verify this with the Axiom Contract Management administrator.

c. Group and price the desired set of APC claims for the desired simulation (or simulations, if
you are performing a comparison). For more information, see Group and price APC and
eAPG claims.

2. Create a drill-down report using the desired Claim tab or Line Item tab fields, then add filters to the
report as needed to limit the data included, and then generate the report.

For more information, see the following:

l Build a new drill-down report
l Apply filters to a drill-down report
l Export a drill-down report

Run a saved group and price task
These instructions are for running a saved group and price tasks from the Claims Group and Price Tasks
page.

To run a saved group and price task:
1. From the Claims menu, select Group and Price.

2. Click the Saved Tasks tab.

3. If needed, filter the list for the simulation and Task Type.

4. On the right side of the page, for the desired task, click Run Once.
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The page displays a brief notification that the task was queued.

5. To delete a task when finished, in the row for that task, click Delete.
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Calculating claims
Claims calculation is the process by which a claim is filtered through the defined contract structure to
generate a claim payment voucher and a total expected payment amount. Claims are calculated in Axiom
Contract Management in two ways:

l Nightly import process —Occurs during the import process and is done without any user
intervention.

l On-demand calculation —Users can perform ad-hoc claim calculation from the Recalculate Claims
feature, and also while viewing a claim from the Claim Detail page. Administrators can recalculate
claims from the Recalc History page, and calculate simulated adjustments to claim charges.

Typically, every claim that enters the system calculates automatically during the nightly auto-import
process; however, there are times when you need to manually recalculate a claim using the ad-hoc
methods.

You might need to recalculate a claim for several reasons. Themost common reason is a contract term
modification. If a claim is calculated on a specific clause of a contract and that clause is adjusted in a way
that the claim nowqualifies for another clause or rate, a recalculation is warranted.

� Automatic calculation
Every new claim entering the system that has a matching Contract → Version → Provision →
Clause/Term will automatically generate an expected payment during the auto-import process. This
ensures that new information entering the system can be used during reporting and other analysis. No
user intervention is needed, but it is important to note that if the contract structure is not kept up to
date, then new claims that enter the system will not generate an expected payment. It is also important
to note that even though a contract may exist for payer, if it is not modeled accurately, then the
expected payment information will probably be inaccurate.

Keep an eye on contracts approaching expiration and make sure to extend the expiration date (if
applicable), or model the new contract in Axiom Contract Management.

� Ad hoc calculation
You can select to recalculate a claim at any time using the Recalculate Claims feature (Claims >
Recalculate). You can recalculate claims by a variety of criteria:

l Recalculate by patient account number
l Recalculate by Claim Number/UCRN
l Recalculate by Date Range
l Recalculate by Contract
l Recalculate by Insurance Plan Code
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NOTE: You can also recalculate a claim from the Claim Detail page.

Recalculate a claim
Each of the following criteria give you more flexibility in determining which claims to recalculate.

l Patient Account Number and Claim Number/UCRN are typically used to calculate single
accounts/claims.

l Date Range and Contract allow you to select several claims at once for calculation.
l Insurance Plan Code allows you to recalculate all claims that have a specific payer code.

You select the claim to calculate in the Claim Type field. Your options are Institutional, Professional, or All.
Since professional claims are stored in Axiom Contract Management as separate bills, you must select
the appropriate Claim Type before calculating a claim.

The Claim Status field allows you to select whether to calculate on the Live accounts for a particular
account # or all accounts (Live and Inactive).

NOTE: Reports in the system are based on the Live accounts, so it is not always required to
recalculate inactive claims unless you are including those in your analysis.

To access Recalculate Claims:
In themain menu header, click Claims > Recalculate.

The Recalculate Claims page is displayed. Use the criteria explained in the following sections when
determining what to calculate.

NOTE: You can also recalculate a claim directly from a claim’s Claim Detail page. For information, see
Recalculate a claim from Claim Detail.
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� Recalculate by Patient Account Number
You can calculatemultiple accounts simultaneously by separating account numbers with a comma. If
there are claims that match your criteria, a message informs you that the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

To recalculate by account number:
1. In the Recalculate Claims tab, click the Patient Account Number option.

2. In the Patient Account # field, enter the account number.

3. From the Claim Type drop-down, select the type.

l Institutional
l Professional
l All

4. From the Claim Status drop-down, select the status:
l Live Claims Only
l All

5. From the Simulation drop-down, select the simulation.

6. Click Recalculate.

� Recalculate by Claim Number/UCRN

IMPORTANT: This option should only be used if you are using the system’s Claim Number / UCRN
feature.

If any claims match your criteria, a message displays that says the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

To recalculate by Claim Number / UCRN:
1. In the Recalculate Claims tab, click the Claim Number/UCRN option.

2. In the Claim #/UCRN field, type the number.

3. Select the Claim Type:
l Institutional
l Professional

4. Select the Claim Status.

5. Select the Simulation.
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6. Click Recalculate.

� Recalculate by Date Range
The date range option allows you to select all claims that fall between a specific date range and
recalculate them.

To recalculate by date range:
1. In the Recalculate Claims tab, click theDate Range option.

2. In theDate Type field, select the type of date:

l Discharge Date – Date the account was discharged
l Admit Date – Date the account was admitted
l Submission Date – Date the bill was submitted to the payer for reimbursement

3. For the Start Date and End Date fields, select the desired dates.

You can enter dates manually, or use the drop-down calendar. Clicking any date sets that as your
start/end date.
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4. Select the Claim Type:
l Institutional
l Professional

5. Select the Claim Status.

6. Select the Simulation.

7. Click Recalculate.

If there are claims that match your criteria, a message informs you that the recalculation task has been
queued successfully. If no claims match your criteria, a message informs you that no claims met your
selected criteria, and to try again.

Administrator's Guide Axiom Contract Management │ 142



� Recalculate by Contract
Selecting the Contract option allows you to select whole contracts. Calculating by contract gives you
added flexibility by allowing you to filter down into contracts, versions, or even to the provision level. For
example, to calculate only an outpatient provision of a contract, you can drill down to that provision and
select it for recalculation.

In the following example, a user is recalculating provisions 6 and 7 of their Cigna PPO contract, as well as
their entire ORG2 - BCBS contract.

Notice that the Contract option also includes the same features as the Date Range selection dialog,
allowing you to narrow your criteria even further.

To recalculate by contract:
1. In the Recalculate Claims tab, click the Contract option.

2. In the Contracts table, from the Current View drop-down, select the desired simulation.

3. Select the desired contract/version/provision to recalculate. You can select more than one.

4. In theDate Range section, enter the date range criteria (if you want to calculate the entire
contract, then entering date information is not required).

5. In the Enter a name for the task field, type a name for this recalculation.

Administrator's Guide Axiom Contract Management │ 143



6. Click Recalculate.

If any claims match your criteria, a message informs you that the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

� Recalculate by Insurance Plan Code
This option allows you to calculate claims for a single insurance plan code instead of calculating all the
insurance plan codes assigned to a contract version. For example, you can use this option when a new
insurance plan code has been added to a version and you do not want to re-process an entire version
and all plan codes, just the claims with the new code.

To recalculate by insurance plan code:
1. In the Recalculate Claims tab, click the Insurance Plan Code option.

2. In theDate Type field, select the type of date:

l Discharge Date – Date the account was discharged

l Admit Date – Date the account was admitted

l Submission Date – Date the bill was submitted to the payer for reimbursement

3. For the Start Date and End Date fields, select the desired dates. You can enter dates manually, or
use the drop-down calendar. Clicking any date sets that as your start/end date.

4. Select the Claim Type:

l Institutional
l Professional

5. In the Claim Status field, select whether to use Live claims or All.

6. In the In. Plan Codes table, do the following:
a. In the Current View field, select the desired simulation.

b. In the list of insurance plan codes, expand the organization and select the check box for the
desired code. You can select as many codes as desired. You can also select the parent Org.
code instead, which recalculates all claims that have that Org. code, including all the Payer
codes associated with that Org code.

7. Click Recalculate.

Save and schedule calculations
You can name and save calculation tasks and then schedule those tasks to run using the Axiom
Scheduler. This feature is great for repetitive calculations or when you need to schedule a large
calculation to run after hours or on a recurring, scheduled basis.
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To save and schedule a calculation:
1. In themain menu header, click Claims > Recalculate.

2. In the Recalculate Claims tab, select the claim to calculate.

3. In the Enter a name for the task field, type a name for the recalculation.

4. Click Create a Saved Task.

5. In the Desktop Client, in the Explorer task pane, access the Scheduler at Libraries > Scheduler
Jobs Library > Contract Management.

6. If needed, create a new job for the calculation. Please see Scheduler for more details regarding
assigning and completing jobs and tasks using the Scheduler.
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You can access and run your saved tasks.

Run a saved recalculation task
You can rerun your saved recalculation tasks.

To run a recalculation task:
1. From the Claims menu, select Recalculate.

2. On the Claims page, click the Saved Tasks tab.

The list of saved Recalculation Tasks displays all the saved tasks in all the simulations, by default.

3. If desired, from the Simulation drop-down, select the desired simulation to filter the list of tasks.

4. Locate the tasks to run and then, in the task row, click the Run Once button.

A briefmessage displays that the task has been queued to run, and the “0” in the Recalculations
Queued section changes to “1” (or the number of tasks you selected to run).

5. To delete a task, click theDelete button in the row for that task. In the confirmation dialog, click
OK. A briefmessage displays that the task has been deleted.

Recalculate a claim from Claim Detail
Users modeling contracts can now recalculate a claim from the Claim Detail page instead of using the
Recalculate Claims page if they want to recalculate just the claim they are viewing. This feature allows you
to recalculate a claim and then refresh the page to view the recalculation without having to navigate
between different pages and dialogs.
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To recalculate a claim from Claim Detail:
1. From the Claims menu, select View a Claim.

2. Locate and view the claim.

3. In themenu on the left, click Recalculate.

In the Recalculations Queued section (on the right in the blue header), the “0” changes to “1.”

NOTE: If you already have recalculations waiting in the queue, or if other users have
calculations waiting in the queue, the number is incremented. If you select another claim to
recalculate before the first one is finished, the number increments again.

When the “1” changes back to “0,” the recalculation is finished.

4. Refresh the page in your browser to view the recalculation results.

The data in the Last Recalc: field has changed to reflect the new recalculation date.
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For additional recalculation options or to recalculatemultiple claims, use the Recalculate Claims feature.

View claims recalculation history and rerun claims
Administrators can access a history page for recalculated claims. The Recalc History page contains a log of
all recalculated claims, whether recalculated in a batch or individually, and the ability to rerun any listed
recalculation.

The history includes:

l Recalc ID – Recalculation ID number
l Run By – Username of person/entity/process that ran the recalculation
l Start Date/Time – Start date and time of the recalculation
l End Date/Time – End date and time of the recalculation
l Claims Selected – Number of claims selected for recalculation
l Claims Processed – Number of Claims Selected that triggered a contract clause/term for payment
l Error Count – Number of errors that occurred during processing. Any errors found are displayed

at the bottom of the page in the Recalc History Errors section.
l Recalc button – Click to rerun any of the listed recalculations
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To access the Recalc History page, from themain menu, click Admin > Recalc History.

Verifying claims reimbursement calculation
Claims are automatically calculated during the nightly import process. However, theremay be cases in
which a claim does not calculate an expected reimbursement. Use the following list of checkpoints to
ensure that claims are calculated properly, and to help you figure out why an expected reimbursement
did not calculate as expected.
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Claim calculation checkpoints

� Step 1: Verify that the claim dates fall within the contract version Start and
Expiration dates
Navigate to the contract version and check the Start and Expiration dates. For a claim to calculate
correctly against a contract version, the dates on the claim must fall within the contract version’s date
range, which is its active period.

� Step 2: Verify that the Payer Code on the claim matches a code assigned to the
contract

1. In Ins. Plan Code column of the contract version, click the View/Edit button.

2. In the Insurance Plan Code dialog, look in the Payer Code column and confirm that the claim
insurance Payer Code is assigned to the contract:
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� Step 3: Verify that the Claim Bill Type is built into the contract version Provision
1. On the contract version row, click theDetails link to go to the Provision page.

2. On the Provision page, select the desired provision by clicking the blue square at the beginning of
the row. The row is highlighted light blue.

3. In the sidemenu, click Convert. The Provision Settings dialog opens, displaying the Types of Bill on
the provision. You may need to expand the top category row to see the underlying bill types, as
shown in the following example.

� Step 4: Confirm that the claim has criteria that match the contract build
1. Review the claim and compare the criteria to verify that it matches the capture data specified on

the contract clause/term.
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2. Check that the contract also has a clause that captures non-reimbursable claims. In addition to
criteria that catches reimbursable claims, each contract should have a final clause that captures
non-reimbursable claims. Without a capture clause/term, the claim will not calculate expected
reimbursement. In the following example, a No Qualifying clause is used.
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Working with Standard Reports
This chapter covers building a standard report.

Access standard reports
Use these instructions to access standard reports in Axiom Contract Management.

1. In themain menu header, click Reports > Reports.

The Reports page opens to the Report List tab. All previously saved reports are located here.

8

Administrator's Guide Axiom Contract Management │ 153



2. Do one of the following as desired:

l To create a new report, click theNew tab, and then follow the instructions in Create a new
standard report.

l To view an existing report, select the report from the list and then click the View/Edit tab.

Create a new standard report
Use these instructions to create a new standard report.

To create a new report:
1. In themain menu header, click Reports > Reports.

2. Click theNew tab.

3. In the Report Name field of the new report form, type a name for your report.
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4. From the Report Type drop-down, select the type of report template to run.

5. Select a report date range. The report parameters available depend on the selected report type.
All reports have a date range parameter. You need to set a Start Date and an End Date for the
report.

a. In the Start Date field, click the drop-down and select a date from the calendar.

b. In the End Date field, click the drop-down and select a date from the calendar.
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6. If the type of report you are creating requires you to select a contract against which to run the
report, from the Contract drop-down, select an existing contract.

7. If the type of report you are creating requires other parameters, these display in the Parameters
section. Select any that apply to your report.

8. To add filters to your report, in the Parameters heading bar, click the arrows to the left of the
Advanced button. Do one of the following:

l From the Filter drop-down, select a filter.
l Build a filter.

9. Click Save. The report generates.

View a standard report
After the standard report is processed, the system displays the report in theWeb Client. The initial view
is the detailed view, meaning most of the rows are expanded, except for themost granular level; those
usually are collapsed, with a boxed plus symbol to the left of the rows. Expanded rows have boxed minus
symbols to the left.

To change the view of a report:
l To expand the details for an item, to the left of the item, click the plus symbol (+) (outlined in red in

the following example).
l To access a claim from a report, expand the account row and then click the account number link.
l To view selected filters, on the left above the blue report column headings, click the plus symbol

next to Selected Filters.

NOTE: These are not the same as Advanced Filters.

l To hide report details, click theHide Detail check box(outline in green in the example) and then
click Save. Report details usually include themost granular level of detail in a report, such as
individual claim level account numbers and patient account information.

l To change the size of the report on the page, select an option from the Page Width drop-down
(outlined in orange in the following example).
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Report example

Export a standard report
Exporting reports to Microsoft Excel can be a useful tool for additional claim and data analysis. Exporting
to Excel allows you to perform enhanced data sorts, comparisons, calculations, and edits.

To export a standard report to Excel:
1. Navigate to the desired report.

2. In the gray toolbar at the top of the report, click the Export to drop-down, and select Excel.

A Download button displays to the right of the export drop-down, which now displays as “Excel.”

3. Click Download. The Excel file name displays in the lower left corner of the page. Click the file to
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open it.

4. In Excel, you can expand report details similarly to the way you do in Axiom Contract
Management: by clicking on the plus icon (+) to the left of an item.

Example report with expanded filters

5. To expand all filters, click the number of highest value in the group that sits just above and to the
left of cell A1.

Each greater number represents a deeper level of expansion. In the image below, number 5 has
expanded the report down to the claim level.
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Example of fully expanded report

Edit or delete a standard report
Use these instructions to modify and save an existing standard report, or to delete a standard report.
You can make changes incrementally if you want, by saving the report after each parameter change.

These instructions are generalized; not all reports contain the report parameters used in these
instructions, and some reports contain parameters not mentioned here.

NOTE: You cannot change a report’s type.

To modify a standard report:
1. In the Report List tab on the Reports page, click the report to edit and then click the View/Edit
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tab.

2. To change the report name, in the Report Name field, type a new name.

3. To change a date parameter, expand the Parameters section if needed, and then select a new date
range from the start and end date drop-downs.

4. To change the report’s simulation, in the Simulation drop-down of the Parameters section, select
a different simulation.

NOTE: If you change the simulation, you may be required to change the contract as well, since
contracts are simulation specific.

5. To change the contract, in the Contract drop-down of the Parameters section, select the desired
contract.

6. To add a filter to the report:
a. Click the arrows to the left of the Advanced button to open the Advanced parameters.

b. From the Filter drop-down, select the desired filter.

7. Click Save.

To delete a standard report:
1. In the Report List tab on the Reports page, right-click the desired report and select Delete.

2. In the confirmation dialog, click OK to delete the report.

Run APC and eAPG Edits Reports in any simulation
You can run APC/eAPG edit reports targeting a simulation environment other than Live. Although there
is a Simulation drop-down menu for this report, previous to the 2019.1 release, the report always ran on
the Live simulation for APC/eAPG reports, regardless of the simulation selected. Now you can view edits
that occur on APC and eAPG claims grouped within any given simulation.

To run an APC/eAPG Edits report:
1. Click Reports > Reports.

2. Click theNew tab.

3. In the Report Name field, type a name for this report.

4. From the Report Type drop-down, select one of the following:
l Edits - EAPG
l For APC, Edits - OCE APC.

5. Expand the Parameters section if needed, and select a Start Import Date and an End Import Date.

6. From the Simulation drop-down, select the desired simulation.
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7. From the Contract drop-down, select the desired contract(s).

8. Click Save.

The report generates.
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Working with drill-down reports
Axiom Contract Management’s drill-down reporting feature enables you to createmulti-level, complex
reports with expandable / contractible sections. Drill-down reports are interactive and highly modifiable.
After generating a report, you can sort and rearrange columns, add or delete additional rows or columns,
apply or remove filters, etc.

Accessing drill-down reports
To access Drill-Down Reports:

l In themain menu header, click Reports >Drill-Down Reports.

Drill-Down Reports opens in a new browser tab. To get started, see Organizing drill-down reports.

9
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Organizing drill-down reports
The initial page displays your organization’s drill-down report folder structure that stores all previously
saved reports. From this page, you can add a new folder to the structure, search for and open a saved
report, or click Create New Report to access the report builder.

Drill-down reports page example

The system comes with the following folders:

l Claims
l Line Items

You can add and delete folders, and create additional subfolders as desired.

IMPORTANT: Be aware that when you make a change to any of the folders, it affects all users.

This initial set-up categorizes reports by type of report. Other options may be User Name or Department.
How facilities use the folder structure is up to them.

� Add report folders
First determine whether the new folder should be for a new category or a subcategory.

To add a new category folder:
1. In the Categories panel on the left, click +Add New.

This creates a new folder named NewCategory# that you can rename.

2. Rename the new category and then press Enter.

The new folder sorts alphabetically into the structure.
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To add a new subcategory folder:
1. In the list of categories, right-click the existing category, and select Add New.

2. Rename the subcategory, and press Enter.

If a category has subcategories, an arrow icon (>) displays to the left of the Category name. To
display all subcategories, click the arrow.
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� Edit or delete report folders
You can rename or delete report categories and subcategories.

To rename a category or subcategory:
1. Right-click the category, and select Rename.

2. Change the name, and then press Enter.

To delete a category or subcategory:
1. Right-click the category, and select Delete.

2. In the confirmation dialog, click OK.
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� Edit the folder structure
You can rearrange folders and subfolders by dragging and dropping them to new locations. You can
move reports within folders the sameway. Just keep in mind that any changes you make to a folder’s
structure or contents affects all users.

To move a folder to a different category folder:
l Drag a folder or subfolder to another category folder. Release themouse button when the

destination folder name changes color.

In the following example, the user drags the Line Items folder to the Department Denials folder.

� View the list of reports in a folder
To see the reports saved in folders:

1. Click the folder name. The reports display in the right pane under the name of the folder.
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2. To view summary details about a report, click the report name.

An information box displays just below the report name, showing more details about the report,
including the dates the report was created and last modified, the name of the user who modified
it, and any notes that were added when the report was saved.

3. To close the summary details box, click the name of the report again.

� Edit report summary information
In addition to viewing report summary information, you can edit the report name, description, and
folder location.

To edit report summary information:
1. To modify the report name, description, or folder location, on the left of the description, click Edit

info.
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2. In theUpdate Report Detail dialog, edit the desired information, and then click Save.

Configuring drill-down reports
When you view a report with the Columns panel open, the Groupings and Measures tabs display on the
left side of the page. (By default, opened reports initially display with the Columns panel closed.)

Report shown in flat view

These tabs contain all of the data elements available for building reports. When building a report, always
select at least one item from Groupings and at least one item from Measures.
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� Organizing groupings and measures
When organizing groupings and measures, you can use the provided folder structure or create your
own. You can customize the tabs by adding, deleting, and rearranging folders to organize the groupings
and measures data elements as you wish. The folder structure built by one user has no effect on any
other user, nor does how you choose to organize the data elements. However, data elements remain
within their designated tab, Groupings or Measures, and sort alphabetically within their folder. Measures
sort alphabetically first by standard measures, then by calculated fields.

To create a new folder:
1. Determine where the folder should be created.

l To create a main folder, click Groupings (orMeasures), and then click Add New.
l To create a subfolder, first click themain folder, and then click Add New.

A new folder displays, prompting you to name it.

2. Type in the name and press Enter.

In the following image, Dates is a main folder containing two subfolders: Admit and Discharge.

To delete a folder:
1. Click the selected folder.

2. At the top of the tab, click Delete.

3. In the confirmation dialog, click OK.

NOTE: You cannot delete a folder with contents. Delete or move the folder’s contents and
then delete the folder.

To move data elements between folders, do either of the following:
l Drag-and-drop the data element from its current location to the new folder.
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l Right-click the data element, and click Cut. Then right-click on the new folder location, and click
Paste to move the data element.

About drill-down report fields
The following fields are used in drill-down reports.

� Groupings
These fields display as a grouping of rows in the report, in column format. All information requested in
the report is totaled by the selected Grouping. In a report, the first grouping displays as the first column.
Any additional groupings selected are a subgroup of the first grouping picked.

� Measures
These fields display as columns in the report.
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Threemain functions are available to calculate a measure: sum, average, and count. You can also choose
to display themaximum or minimum value for the field.

Measure names displayed in black text are standard measures in the system. Measure names in blue
text are user-defined calculated fields, as shown in the following example.

Calculated fields are listed alphabetically beneath the standard measures in the folder they are saved in.
You automatically see calculated fields in your display. Calculated fields created by other users default to
the folder “Other Users’ Calculated Fields,” which is a subfolder ofMeasures.
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Calculated fields are used to create custom measures in the system. For instructions on creating
calculated fields, see Add calculated fields to a report.

� Add Filters
Use the Add Filters button to select specific criteria from the database to incorporate into a report. Note
that a filter is not required to run a report. However, if no filters are applied, the entire database is
queried.

The Add Filters button displays on the bottom right of the page when you open a drill-down report or
edit or create a drill-down report.

See Apply filters to a drill-down report and the section on Editing and filtering drill-down reports for more
information.

� Claims tab
The Claims tab pertains to all information found on a claim. This information is only available for claims
filed and subsequently imported into Axiom Contract Management. The available Groupings and
Measures are provided in the Columns panel on the left side of the page.

Use the Claims tab to report claim and contract information. You can generate reports to analyze actual
contract performance as well as expected profitability using expected payment information. You can
generate Detailed Tracking Reports to track underpayment recoveries by payer.

� Line Items tab
The Line Items tab provides details from the claim form at the line item level. Only patients whose claims
were filed and subsequently imported into Axiom Contract Management are available. The available
Groupings and Measures are listed in the Columns panel on the left side of the page.
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Use the Line Items tab to report on data at the line item level, including Revenue Code, Service Date, and
Quantity detail.

� Applied Filters
The Applied Filters button is located at the bottom left of the page. The Applied Filters dialog displays all
of the filters applied to the current report.

l To display all the filters from the Claims and Line Items tabs that you selected to apply to the
current report (see the following example), click the up arrows on the Applied Filters button.

l To delete a single filter, click to the left of the value, and press theDelete key.
l To remove all filters, click Clear All on the right of the page. If no filters are attached to a report,

the system will search the entire database for results.

Viewing drill-down reports
All saved reports are available when you first open Drill-Down Reports. The Category section on the left
side of the page contains the folders in which saved reports are stored.

� Open a saved report
To open a saved report:

1. In the Categories panel, click the folder where the report is stored.

2. Hover your cursor over the report name, and click View.
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The report generates and opens.

After generating the report, you can edit it, change the design view, or export it to Excel. Building
and editing reports is covered in Building reports.

3. When finished viewing the report, to return to themain Drill-Down Reports page, in themenu bar,
click Reports >Open.

To open a saved report while working elsewhere in Drill-Down Reports:
1. In themenu bar at the top of the page, click Reports >Open.

You are taken back to the Drill-Down Reports opening page.

2. Click the folder in which the report is stored.

3. Hover your cursor over the name of the report, and click View.

� Open and close the Columns panel
When you open a saved report, the system generates the report and displays the results using the full
page. In this view, you do not see the Groupings and Measures tabs in the Columns panel because the
panel is minimized.

To maximize the panel, click the arrow to the left of the results. In the following images, the one on the
right shows the bar the arrow resides on in blue. You can click anywhere on this bar to maximize and
minimize Columns panel.
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Likewise, while working with a report, you can minimize the Columns panel by clicking on the same bar,
as shown in the following example.
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Building drill-down reports
Use the NewReport page in Drill-Down Reports to create new drill-down reports. To update existing
reports, see Editing and filtering drill-down reports.

Build a new drill-down report
Use these instructions for building a new drill-down report. Creating a report that has filters, and saving it
in the drill-down interface, saves the advanced filter.

To build a new report:
1. Navigate to the Drill-Down Reports page.

2. Do one of the following:
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l Near the top of the page on the right, click Create New Report.
l In the header menu, click Reports >New.

3. Of the tabs on the right side of the page, click the tab for the type of data being retrieved. The
Claims and Line Items tabs contain information found on the patient’s UB04 or 837 claim forms,
and reside within Axiom Contract Management.

On the left side of the page are two tabs, Groupings and Measures.

NOTE: You must select at least one parameter from both tabs to generate and display a
report.

4. On the left side of the page, in theGroupings tab, click the plus sign (+) to expand any folders as
needed to locate report groupings options.
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5. Double-click a groupings option to add it to the report. When added, that option displays on the
right side of the page above the Generate button, as shown in the following example. Select more
row groupings if desired.

NOTE: If you select more than three groupings, only the first three display when you generate
the report in hierarchical view. All groupings display when you generate a report in flat view.
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6. Click theMeasures tab, expand any folders as needed, and then double-click the desired
measures, one at a time, to add them to the report. If you do not see themeasure you need, you
can create one. See Add calculated fields to a report.

l To add a measure to the report as SUM of that measure, double-click themeasure.
l To add a different calculation, right-click themeasure, and select a calculation option from

themenu as shown in the following example.
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When you chose the calculation option for the desired measure, the selected measure
displays to the right of the selected grouping. This is the order in which the columns in the
report display. You can rearrange them or delete a grouping or measure before or after you
generate the report if you change your mind.

l To remove any selected options from the report before generating, right-click the option,
and select Delete.

l To rearrange report columns, drag and drop the columns to the desired order. In the
following example, the user drags themeasure COUNT claims to themiddle row. The red
arrows showwhere themeasure label will start, which in this example, is after Payer Code:

7. In theData View section to the right of the Generate button, select the report grid type:
l Hierarchical – Select this option to display the report with grouping columns arranged in a

hierarchy.
l Flat – Select this option to display the report with grouping columns arranged side-by-side.

8. Click Generate.

9. If desired, save the report so you can use it later.
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Add calculated fields to a report
If you need a measure that does not exist, you can build a calculated field. You create calculated fields by
choosing current measures and creating expressions with mathematical functions to calculate the
desired results.

To create a calculated field:
1. Open the drill-down report to which you want to add a calculated field. If you are creating a new

report, select the tab for the type of report (e.g., Claims or Line items).

2. In themenu bar at the top of the page, click Reports > Create Calculated Field.

The NewCalculated Field dialog opens.

NOTE: You cannot use a calculated field in an equation for another calculated field.

3. Do one of the following:
l To use filters from a saved report, click theUsing option and then select a report from the

drop-down list. Reports available in this list are based on the tab that you are on when
building the calculated field. A calculated field on the Claims tab can use only the filters from
other Claim reports.
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NOTE: Using the filters option limits the calculated field to only the claims found in the
selected saved report. For example, to compare pediatric claims to all claims, you need
to create a calculated field for SUM(claims) with a filter from a report limited to pediatric
claims. You can select only one report to apply as a filter to a calculated field. However,
the report used for the calculated field can contain as many filters as you need.

l If you do not want to use a filter, leave the default Not using selected.

4. Build the expression by selecting measures from theMeasures list on the left:
a. Click the desired measure, and select the desired function from the list of available

functions. Themeasure is added to the Expression box. Now you need to add an operator
or mathematical symbol.

b. Click the Functions button to select the desired operator, or, for a mathematical equation,
use themathematical symbols on your keyboard (+ - / *) for add, subtract, divide, and
multiply, between your measures to string them together.

NOTE: Do not use special characters, such as dashes and slashes, in a calculated field
name.

TIP: If you make a mistake with the expression, click Clear All and start over.

c. Add the next measure and symbol, as needed, until your expression is complete.

TIP: If you know the complete expression, you can type it into the Expression box
manually instead of selecting Measures and Functions from themenus.
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d. Click Save.

e. In the Save As dialog, select a location to store themeasure on theMeasures tab, and then
in theName field, type a name for it.

f. Click Save and Return.

The newmeasure name displays in blue text on theMeasure tab in the folder you selected.
The name becomes a column header when added to a report.

Edit or delete a calculated field
Use these instructions for managing your calculated fields.

To edit a calculated field:
1. In the Columns panel, click theMeasures tab.

2. In theMeasures list, right-click the desired calculated field, and select Edit Calculated Field.

3. In the Edit Calculated Field dialog, do any of the following as desired:
l To clear the entire expression in the Expression box, click Clear All and then rebuild the

expression.
l To replace part of the expression, use the backspace key to remove the part you want.
l To add a measure, in theMeasures list, click the desired measure, and select the calculation

type from the pop-up menu.
l To add an operator between measures, type a mathematical symbol (+ - * /) or click the

Functions button, and select a function.
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4. Do one of the following:
l To save themeasure as a newmeasure, click Save As and then, in the Save As dialog, select

a location for themeasure. In theName field, type a new name. Click Save and Return.
l Click Save.

To move a calculated field:
1. Right-click the calculated field, and select Cut.

2. Select the desired location / folder in theMeasures tab, right-click and select Paste.

TIP: You can also drag and drop calculated fields to different locations in theMeasures tab.

To delete a calculated field:
1. In theMeasures tab, right-click the calculated field, and select Delete.

2. In the confirmation dialog, click OK.

NOTE: You cannot delete calculated fields that are attached to a report.

Apply filters to a drill-down report
Use these instructions for applying filters while building a drill-down report. Filters enable you to more
precisely select data from the database for your reports.

To apply filters:
1. On the bottom right of the page, click Add Filters.

2. To change the type of filter you are applying, click the Filter by drop-down, and make a selection
(see the following example). Each type has an underlying folder structure that groups together
similar data elements.

3. In the Fields section, click the plus symbol (+) next to the type of field you want, to view the fields
available in that folder.
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4. To select a filter to apply to the report, click the filter name.

For some filters, a list displays of the data values you can select for that filter.

For other filters, a drop-down list provides selection options:
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� To search for filter values:
l Do one of the following:

o Scroll down the entire list until you find the desired value, then click the check box
next to the value, and click theUse These button on the right to save the value.

o If you know the exact value to filter with, type it into the box, and then click Filter.
The system displays this value. Click the box and then click Use These to apply the
filter.

o Use the wild card feature. If you do not know the exact value for the filter but you
know some or part of the value, type the percent (%) symbol in the field along with a
known portion of the number/text, and click Filter. This shortens the list of values to
search from. For example, to find a certain ICD Procedure number that relates to the
heart, type “%heart.” The system provides all the ICD Procedure codes that include
the word “heart” in the description. Select the desired value(s), and click Use These.
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l Additionally, you can select more than one filter value by selecting multiple check boxes.

l To select all of the values except one, click Check All, which selects all of the filter values.
Then, you can simply uncheck the values that you do not want to use in the report.
Remember to click Use These to set the filter.

5. Each time you select a filter, click Use These to set this filter for the report.

6. After selecting the desired filters, at the bottom left of the page, click Applied Filters to view the
filters and confirm the selected criteria.

7. After adding all of the groupings and measures to the design view and applying the filters, click
Generate to view the results. The results of the report display.
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Save a drill-down report
Saving a drill-down report saves all of the selected groupings, measures and filters, and any changes to
the report format or layout.

We recommend that you save the report while viewing the report layout. This ensures that the report is
saved as the correct type (Claims or Line Items).

Report layout view
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To save the report:
1. In themenu header at the top of theDrill-Down Reports page, click Reports > Save.

The Add NewReport dialog opens. The Tab field defaults to the Report tab that you were on when
you saved the report.

2. In the Folder field, select the folder in which to save the report.

3. In theName field, type a unique name for the report. Give the report a name you can easily
remember and identify later.

NOTE: When naming a report, do not use special characters such as dashes or slashes.

4. If desired, in theDescription field, type a detailed description of the report.
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5. Click Save.

You can continue to work on the report and either save the changes or select Save As to save as a new
report with a new name.

Export a drill-down report
Use these instructions to export a copy of drill-down report results to Microsoft Excel, which transfers the
report into an Excel spreadsheet.

The system defaults to Export Row State (Expanded or Collapsed) and Export Filter Information. If you do
not want to export any of these features, highlight and click the desired setting to clear the check mark.

To export a drill-down report:
1. Generate the report.

2. In menu header above the report results, click Settings > Export to Excel, and then select the
following as desired:

l To include the ability to expand entire row levels at a time, click Export Row State
(Expanded/Collapsed).

l To include a list of filters applied to the report in the report results, click Export Filter
Information.
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l To verify your selections, click Settings > Export to Excel The option(s) you selected should
have a check mark to the left, as shown in the following example:

3. Below the dark gray menu header, click the blue Export link.

The report generates. This may take several minutes if the report is long.

The report file downloads to your computer, and a link to the file displays in the bottom left
corner of the page, as shown in the following example.

4. At the bottom of the page, click the Excel file to open it.

The following example shows a report generated in hierarchical view that was exported with the
options Export Filter Information and Export Row State (Expanded/Collapsed) selected.

The applied filters export as a collapsible list above the report results, for reports in flat view and in
hierarchical view (see list outlined in red in the following example).
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Each report level has its own expand/collapse button ( ) to the left, which you can use to
expand and collapse report sections.

On the left, above the list of filters, is a row of numbered squares (outlined in blue in the following
example). Use these buttons to expand/collapse all rows of the level that corresponds to each
button.

5. To view report details, do any of the following:

l To expand/collapse individual rows, click that row’s buttons ( / ).

l To expand all level 1 sections, click the second square ( ) in the row.

l To expand all levels, click the last square in the row, which is the third square ( ) in the
example.

l To collapse all expanded sections, click the first square ( ).

Editing and filtering drill-down reports
Drill-down reports are interactive, allowing you to filter the report to display only what you want.
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Report filtering options
Several buttons, icons, and drop-down menus display in rows above the gray shaded field names on a
generated report. These functions allow you to further edit the report.

� Limit button
The Limit button sets additional report filters. For example, to display results for Emergency and Urgent
only, select the check boxes to the left of their names, and click Limit.

This sets these Admit Type selections as an additional filter. They will be the only results displayed:

To remove applied limits, see Remove an applied filter.

� Rows menu
Use the Rows menu to make selections from the results. For example, if you sorted charges in
descending order to reveal the Admit Sources with themost charges and you are only interested in the
top five Admit Source, click Rows > Select > First 5, which selects the first five names displayed.
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l To display the top ten, go back to Rows > Select >Next 5, which selects the next five Admit
Sources listed.

l To display only the top four Admit Sources:

a. Select Rows > Select >None; this clears all of the selected Admit Sources.

b. Manually click the top four in the report. When all desired Admit Sources are selected, click
Limit to remove all of the non-selected Admit Sources from the view, displaying only those
selected.

NOTE: When you select and limit rows of data from the results, this information is set as a
filter, which is then visible in the Applied Filters dialog. If you make an error, open the Applied
Filters dialog, and remove the new filter.

You can also use the Rows menu to expand and collapse sub-grouped rows when a report uses multiple
groupings.
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� View menu
Change the grid type between Hierarchical and Flat. This is the same as selecting Flat view or Hierarchical
viewwhen viewing the report in design view.

For examples of how to use these views, see Add a grouping as a subtotal.

� Settings menu
Use this menu to set the formatting for reports exported to Excel.

For instructions on exporting a report using this menu, see Export a drill-down report.

� Design View
Design View is report-building view. In Design View, you can add, delete, or rearrange the groupings and
measures in a report. Although the following example shows a new report, you can edit existing reports
in Design View. For instructions, see Change report column order.

Groupings and measures are added to the system in the order they were selected, with groupings placed
beforemeasures. However, you can change the order of groupings and measures at any time (groupings
still order together beforemeasures). For instructions, see Change report column order.

Sort report columns and rows
When building a report, you can easily sort and rearrange report columns.
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After generating a report, you can modify the results using various functions. For example, you can alter
or sort data, add or delete additional rows or columns, or continue to drill down into the report to view
more specific results.

As an example, the following image displays partial report results using the following criteria:

l Filter: DRG = 291, 292, 293
l Grouping: Admit Source
l Measures: Sum Claims, Sum Total Charges

To sort report columns:
l Click one of the gray report column headings. A small up or down arrow displays to the right of the

column name to indicate the column is sorted in either ascending or descending order.
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l You can also sort columns by right-clicking a column heading and selecting Sort, and then from
the pop-up menu, selecting Ascending or Descending.

l Right-click a measure heading to get the same options, and to select a decimals option which,
when highlighted, lets you adjust the number of decimal places displayed in your data, as shown
in the following example.
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Add a grouping as a subtotal
When you build a report with more than one grouping, the system subtotals the second grouping
underneath the first. For example, to see all of the Bill IDs associated with each Admit Source, double-
click the Bill ID field in theGroupings tab. The system displays the following:

After generating, the report displays a plus symbol (+) to the left of the check box in each row:

To display all of the rows that subtotaled under a field value, click the plus symbol (+). You can sort or
delete these subtotaled rows, as well as sort the columns.
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When building reports with multiple groupings, the system defaults to the Hierarchical view as seen in
the previous image. This is one of two views available for displaying data. The other is the Flat view. The
Flat view displays groupings side-by-side, as shown in the following example.

NOTE: Reports with more than three groupings must be run in the flat view. Also, while the
hierarchical view subtotals the groupings, the flat view does not provide totals.
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To change from the default Hierarchical view to the Flat view, do one of the following:

l Before clicking Generate to run the report, instead, for Data View, click the Flat option.

l After the report is generated, from the View menu, select Grid Type > Flat.

Notice that in the following example, Hierarchical is the view being displayed. Likewise, if the
results display as Flat, you can follow the same steps to change it to Hierarchical.

Change groupings
After building and generating a report in hierarchical data view, you can change groupings without
having to delete the field, add the new grouping, and regenerate the report. You can use the drop-down
arrow immediately to the right of the first grouping to select the new field.

When a report is in hierarchical view, the first grouping is a drop-down selectable field, which makes it
easy to change it to a different grouping.
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To change the first grouping for a report displayed in hierarchical data view:
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l In the first column heading, click the drop-down arrow to the right of the column name, then
locate and click a different grouping.

First grouping with drop-down arrow outlined in red

Selecting a different grouping from the list

The report regenerates with the new data, as shown in the following example:
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Notice that the data have changed in the two measure columns because themeasures now apply
to the new grouping.

Change report column order
Use design view to change the order of a report’s groupings and measures columns before or after
generating the report. You can also remove groupings and measures from your report in design view.

NOTE: Groupings always precedemeasures in report layout, regardless of how you order them. You
can re-order groupings within a report’s set of groupings, and re-order measures within the report’s
set ofmeasures. You cannot put a measure before any grouping, however. Even if you do, when the
report generates, themeasure will be grouped with the other measures in the report.

To access design view without opening the report:
1. On themain Drill-Down Reports page, in the Categories panel, click the folder where the report is

saved.

2. On the right side of the page, click the name of the report to open the report summary
information box.

3. On the left side of the summary information box, click Design.
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The design view of the report opens on the right.

To access Design View from an open report:
l Above the report, click Design View.

To change the order of groupings or measures:
1. Click the grouping or measure to move and drag it to its new location.

2. When the two red arrows display in the desired position, release themouse button.

Themeasure columns are now in the new order:
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To remove groupings or measures from the report:
l Right-click themeasure or grouping to remove, and click Delete.

Remove an applied filter
When filtering drill-down report results, you may apply a filter that you later want to remove rather than
recreate the report.

To remove an applied filter:
1. At the bottom left of the page, click the arrows to the left ofApplied Filters.

The Applied Filters dialog opens, showing the filters currently applied to the report.

2. To clear a single filter, click the blue box to the left of the filter, and then press theDelete key. The
filter is removed.

3. To clear all filters, click Clear All.

To close the filter box, click the arrows to the left ofApplied Filters.
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When the filter box closes, the report automatically regenerates with the updated filters.

Delete a saved drill-down report
You can delete reports you no longer need.

To delete a drill-down report:
1. On themain Drill-Down Reports page, locate the desired report.

2. Right-click the report, and then select Delete.

3. In the confirmation dialog, click OK.

IMPORTANT: If you accidentally confirmed a deletion, you need to recreate the report; a
deleted report cannot be retrieved.
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Reporting across tabs
Reporting across tabs allows you to createmulti-sided reports and conduct multi-dimensional analysis.
For example, to see the admit source of claims that include a specific administered drug, you need to
include Line Item filters in your claim report. The drug code is stored with the charge data, while Admit
Source is a reportable field on the Claims tab. From the Claims tab, you can also find the number of
claims and their associated charges, and payments, (see following example). This methodology works for
the other tabs as well.

To report across tabs, you create a multi-tab report, as explained in the following section.

� Create a multi-tab report
The following example uses a Claims tab report. The steps are outlined from the perspective of using the
Claims tab only. However, you can add filters from any tab.

To build a multi-tab report:
1. Open an existing report or create a new one.

2. At the bottom right of the page, click Add Filters.

The Advanced Filters dialog opens.

3. From the Filter by drop-down, select Line Items. This sets a Line Items tab filter without your
needing to switch tabs.

4. In the Fields panel, expand theDemographic folder, and select Line Item Code. In the right side
of the dialog, Line Item Code values display with their descriptions.

5. Click the check box for each Line Item Code filter to apply to the report, and then click Use These.

In the following example, the user searched for a certain kind of drug by using the wildcard search
“%furo%”, which returned two kinds of injection drug.
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6. Close the Advanced Filters dialog.

7. To confirm your selected filter(s), at the bottom left of the page, click Applied Filters. In the
Applied Filters dialog, review the applied filter(s).

Setting a Line Items filter causes the system to automatically filter through the database so that
only claims information related to the criteria selected from Line Items is accessible.

8. Close the Applied Filters dialog by clicking the arrows to the left ofApplied Filters.

9. In the Columns panel, on theGroupings tab, double-click Admit Source.

10. Click theMeasures tab.

11. Double-click the following: Claims, Total Charges, and Total Payments to add them to the report,
calculated as SUM.
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12. After selecting all desired fields, click Generate.

The results show the Admit Source and the number of claims that have administered the selected
drug, along with all associated charges and payments.

NOTE: If you add a new filter that limits the Admit Source on the Claims tab, the Applied Filters
tab shows the filters from both the Claims and Line Items tabs, separating them by filter type.

� Save a multi-tab report
You use the same process to save a multiple-tab report as when saving a single-tab report. However, it is
important to note the tab you are on when you save the report. The Applied Filters from each tab is
saved; however, the report will only save the Rows/Columns of the tab you are viewing at the time that
you save the report.
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In the previous example, if you switched to the Line Items tab before saving, saving the report while on
the Line Items tab would save only the filters, not the selected Admit Source, Claims, Charges, and
Payments from the Claims tab. However, saving from the Claims tab will save the Row/Columns you
selected and all filters applied to the report, regardless of the tab they are associated with.

Improve variance reporting with Posting subcategories
When running drill-down reports on payment and adjustment posting totals, you can break out these
items into subcategories for more detailed reporting. In addition to Total Payment and Total Contractual
fields, there are 10 payment and 10 adjustment fields available in theMeasures column for the Claims
tab in Drill-Down reports. These fields allow you to break out payment and adjustment posting totals by
type for improved contractual variance reporting. You can use these fields to report on refunds, bad
debt adjustments, etc. The new drill-down report fields for adjustments are A1-A10. The new fields for
payments are P1-P10.

NOTE: To take advantage of this postings breakout feature, you need to provide a posting file with
category breakouts for payments and adjustments imported using Axiom ETL. This import can be in
addition to or part of the Axiom Contract Management Full Import job.

In the example below, adjustment fields A1 and A2 are used to break out primary contractual and facility
adjustments:

Using report sets
The Report Sets feature allows you to create single or multi-report workbooks and to schedule them to
run automatically, one time or on a regular basis.
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When you run reports from the Report Sets dialog, the generated reports are automatically exported to
Excel and saved to a selected directory accessible from the Axiom Desktop Client. The default directory is
Axiom > Reports LIbrary > CMAData > ReportSets. From this directory, you can view, save, export, and
delete reports.

Create a report set
Use these instructions to create set of drill-down reports.

To create a Report Set:
1. In themain menu header, click Reports >Drill-Down Reports.

2. On theDrill-Down Reports page, click Reports > Report Sets.

3. At the bottom left of the Report Sets dialog, click Add New Report Set.

A new row displays at the bottom of the Report Set grid.

4. In theName column of the new row, type a name for the new report set. The name of the report
set will also be the name of the report file that exports.

NOTE: Do not use any spaces or special characters in the report name. Limit the title to 15
characters because this is used for the workbook name.

5. If desired, click in theDescription column for the new row and enter a description of the report
set. Spaces and special characters are allowed in the Description field.

The Last Run At column displays the last time the report ran through the Scheduler.
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6. To enable the report set to be scheduled to run at a set time, select the Enabled checkbox.

7. At the right end of the new report row, click Save.

8. In the confirmation dialog, click OK.

The Report Set saves to the grid in alphabetical order.

9. Next, add reports to the report set.

Add reports to a report set
Use these instructions to add drill-down reports to an existing report set, and to set up headers and
footers for the generated reports.

To add reports to the report set:
1. In the Report Set table, find and select the report set.

2. At the top of the Report Sets dialog, click the Sheets tab.

3. On the Sheets tab, at the bottom left, click Add New Sheet. A new row is added to the Sheets
table.

4. Click in theQuery Name field, and then from the drop-down menu, select the drill-down report to
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add.

5. In theWorksheet Name field, type a name for the worksheet. Worksheet names become the
names of the tabs used in the generated report.

All reports, regardless of type (Claims or Line Items), are listed here alphabetically. Each added
report will be an additional sheet in the report set Excel workbook.

6. Near the right end of the new row, click Save.

7. If desired, you can add header and footer information to the sheet. See the following instructions
“Add headers and footers to reports in the set.”

8. Run and view the report, or schedule the report set to run at another time.

� Add headers and footers to reports in the set
To add header and footer information to the sheet:

1. In theHeader/Footer column for the new sheet row, click Details.

2. In theHeader Details section, type the desired information into the fields that corresponds to the
section of the header where you want the text to display.
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3. In the Footer Details section, type the desired information into the fields corresponding to the
footer sections (Left, Center, Right) where you want to place text. To add page numbers and a
time stamp of when the report was created, do the following:

a. Click in the field where you want the page number to populate; then, in the formatting

menu at the top of the dialog, click the page number button ( ).

b. Click in the field where you want to put the date and time that the report was created,

then, in the formatting menu, click the date button ( ), and then click the time button (

).

Example of page number and report time stamp set in the footer

4. At the bottom of the dialog, click Submit Details.
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Run and view a report set
Use these instructions to generate and view a set of drill-down reports.

NOTE: Before you run reports from the Report Sets dialog, confirm that your reports have been
built, that they run correctly, and that they have been saved. Otherwise, you may receive an error
when attempting to run the set.

1. Open the Report Sets dialog: 
a. In themain menu header, click Reports >Drill-Down Reports.

b. On theDrill-Down Reports page, in themenu header, click Reports > Report Sets.

2. In the Report Sets tab, in the row for the desired report set, click Run.

3. In the confirmation dialog, click OK.

4. Open theDesktop Client.

5. In the Axiom Explorer, navigate to Libraries > Reports Library > CMAData > ReportSets and locate
your report.

6. Double-click the report to open and view it.

Drill through the report by clicking the plus buttons on the left, as shown in the following example.

7. After viewing the report, do any of the following:
l Close the report. When prompted to save, select to save it.
l Close the report and export it. To export the report, right-click it and select Export.
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l Close the report and delete it. To delete the report, right-click it and select Delete.

Schedule a report set to run
Use these instructions for scheduling the running of drill-down report sets. You can schedule reports to
run once or on a regular basis. To schedule reports, you need to have CMA Scheduler permissions.

NOTE: Before scheduling a report set, confirm that the reports in the set have been built, that they
run correctly, and that they have been saved.

To schedule and run a report set:
1. Open the Report Sets dialog: 

a. In themain menu header, click Reports >Drill-Down Reports.

b. On theDrill-Down Reports page, in themenu header, click Reports > Report Sets.

2. In the Report Sets tab, in the row for the desired report set, ensure the Enabled box is checked.

3. Open theDesktop Client.

4. In the Admin ribbon tab, click Scheduler.

5. In the Scheduler dialog, on the Job tab, click New.

6. Click the Add button and select Report from Query.
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7. In theNew Job tab, on the right of the Selected Report Set field, click the open folder icon to view
available reports.

8. In the Choose Report dialog, select the report to be scheduled, and then click OK.

NOTE: Only report sets that are enabled for scheduling display in the Choose Report dialog.
For details, see Create a report set.
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9. In theNew Job tab on the left, click Scheduling Rules, and then click Add. A new rule is added to
the right side of the dialog.

10. Set the run day and time:
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a. Under Day Of Week, double-click near the asterisk to activate the cell and then enter a
selection:

l * (Default): The job will be run on all days within the start / end range.

l 0-6: The job will run on the specified day(s), where 0 is Sunday and 6 is Saturday. Use
a comma or a hyphen to separatemultiple days (hyphen if the days are contiguous,
commas if not). For example, you can enter 1,3,5 for Monday, Wednesday, and
Friday, or enter 1-5 for Monday through Friday.

b. Under Hours, specify the time of day (hours) that you want the job to run, in relation to the
specified days:

l * (Default): The job will be run on all hours.

l 0-23: The job will be run on the specified hour or hours, where 0 is midnight and 23 is
11:00 PM. Use a comma or a hyphen to separatemultiple hours (hyphen if the hours
are contiguous, commas if not). For example, you can enter 0,12 to run at midnight
and noon, or enter 0-12 to run every hour from midnight to noon.

c. Under Minutes, specify the time of day (minutes) that you want the job to run, in relation
to the specified hours:

l * (Default): The job will be run on all minutes (essentially the job is run continuously,
once per minute).

l 0-59: The job will be run on the specified minute or minutes of the hour, where 0 is
the first minute of the hour and 59 is the last minute of the hour. Use a comma or a
hyphen to separatemultiple minutes (hyphen if the hours are contiguous, commas
if not). For example, you can enter 0,30 to run at the top of the hour and the half
hour, or enter 0-30 to run every minute from the top of the hour to the half hour.

NOTE: If you specify an hour, then in most cases you should also specify a
minute (such as 0 to run the job at the top of the specified hour). If you enter an
hour but leave theminutes at the default asterisk, then the job will run every
minute in that hour.

11. If desired, schedule email notification to alert users when the report is available for viewing:
a. In theNew Job tab on the left, click Notification.

b. On the right, select the desired settings and specify message content.

12. Click Save and then name and save the schedule in the Contract Management or Product Line
Management folder.
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Security
Axiom Contract Management security roles
Axiom Contract Management provides four main user security roles. Following are summaries of each
role. For details, refer to the following table.

CMA Admin – User with the CMAAdmin security role have Administrative privileges within the
application.

CMA Analyst – Users with the CMAAnalyst security role have standard user level permissions within the
application.

CMA User – Users with the CMAUser security role have restricted rights.

CMA Scheduler – Users with the CMA Scheduler security role have access to the Axiom Scheduler and
ETL tools within the Axiom.

Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Contracts Add, delete,
and modify
all aspects of
the contract

View only View only No access

Simulations Add, delete,
and modify
all aspects of
a simulation

View only View only No access

10
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Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Claims
View a
Claim

l View all
tabs

l Add and
modify
Claim
Tracking

l View
Voucher

l View all tabs
l Add and modify Claim

Tracking
l ViewVoucher

View only No access

Claims Re-
calculate

All features of
re-calculate

All features of re-calculate No access No access

Claims
Track /
Assign
Claims

l Create,
delete,
and edit
user-
defined
categories

l Export
reports

l Build
filters

l Create, delete and
edit user-defined
categories

l Export reports and
claims lists

l Build filters

l View and export
Claims lists

l Run Reports using
existing filters

l Export reports

No access

Import
Data

View only.
We
recommend
contacting
support prior
to deleting
any data
from the
system.

View only View only Create,
delete,
edit Axiom
ETLS to
facilitate
loading
data into
Axiom
tables

Reports l Create,
view, edit
reports

l Build
Advanced
filters

l Create new
l View existing
l Build Advanced filters

l View/run only
l Export Reports

No access
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Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Axiom
Scheduler

No access to
Axiom jobs

No access to Axiom jobs No access to Axiom
jobs

Create,
edit,
delete,
and
schedule
Axiom
jobs
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